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Easy Data Transform data wrangling software for Windows and Mac.



Getting started

1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
The suggested requirements for running this software are:

e Operating system: Windows 11, 10, 8 or 7 (64 bit versions only).
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above, check our website to find a
compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification systems or more
operating systems, but we can't guarantee it. If in doubt, try running an unlicensed trial
version before you buy a license.

1.3  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a few
minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the

Getting Started window appears, click I got this! (or you will just end up back on this page).
You should now see the main window.
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& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help

ODBBE v AR H @  rHowDol?
o Input

From File @

From Clipboard ()

EEmail us questions/feedback

Drag a data file you want to transform onto Easy Data Transform. For example a .csv file or
an Excel .xIsx/.xls file. XML, JSON, fixed width and vCard formats are also supported.
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€

DB8E v A QF @  *HowDoR

¥  Input = vaccination.csv @ o ?i E
From File (@ File: ndy\Desktop\vaccination.csv ...
From Clipboard (%) Type: Delimited text o
~ Transform Delimiter: Automatic -
All transforms = Quoting:  Automatic s
Case @ Encoding: Automatic =
Chop @ Ignore:  First 0 row(s) =
Clone @ v has header
Compare Cels (3) v trim whitespace
Concat Cols () v simplify whitespace
Concat Rows. 1) v ignore emply rows
CopyCols (@ watch file
Count @) Meta info: Mot added -
Cross @ Alias: vaccination
Date Format () Data  Warnings  Info  Com 4 ¥
Decode (@ 3 cols x 5,780 rows
Dedupe @) C B F © showfisti0rows -
= ® country time bcg vacc
. ® 1 afg 1982 10
Filter & 2 afg 1983 10
Gather @ 3 afg 1984 M
Header () 4 afg 1985 17
if G 5 afg 1986 18

EEmail us questions/feedback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header.
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vaccination.csv @ E i
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore:  First O row(s) .

v has header |
rim whitespace
v simplify whitespace i
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Conm 4|}

3 cols x 5,780 rows
C E% f © Show first 10 rows ¥

Guntry time bcg_vacD

All the transforms available for a single dataset are now enabled in the Left pane. Hover
over the transforms to see tooltips explaining what they do. Click on the ? next to a
transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case
of your data.
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

¥  Input = vaccination.csv @ o éi E
From File (@ File: ndy\Desktop\vaccination.csv ...
From Clipboard (%) Type: Delimited text o
~ Transform Delimiter: Automatic -
All transFornlE i Quoting:  Automatic >
Case Encoding: Automatic =
Chop @ Ignore:  First 0 row(s) =
Clone @ v has header
Compare Cels (3) v trim whitespace
Concat Cols () v simplify whitespace
Concat Rows (%) v ignore emply rows
CopyCols @ vaccination.csv watch file
Count @ 2 eols 5.6 rows Meta info: Mot added -
e ® Alias: vaccination
Date Format () Data Warnings Info Com 4 F
Decade ® 3 cols x 5,780 rows
Dedupe @) C B F © showfisti0rows -
= ® country time bog_vacc
. ® 1 afg 1982 10
Filter ® 2 afg 1983 10
Gather (@ 3 afg 1984 11
Header () 4 afg 1985 17
if @ 5 afg 1986 18 .

EEmail us questions/feedback

A Case transform item will now be added.
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

¥ Input E Case @] - =
From File @ B & Filter column 1
From Clipboard (%) [ cou ntry
time

~ Transform
beg_vacc

All transforms =

0 of 3 columns selected

Case @
Chop @ Change case to: Lower case =
Clone @ (Change the case in the selected calumnis).
Is G
Compare Cels (3 Data  Wamings Info  Com ¢ P
=
Concat Cols @ 3 cols x 5,780 rows
Concat Rows (2 [ & @ showfisti0rows ~
CopyCols (@ Jvaccmat'on'ﬁv Y Case country time |bcg_vacc
Count @ 3 cols x 5.8k rows 3 cols x 5.8k rows 1 afg 1982 10
ross (7
Cross @ 2 afg 1983 10
Date Format (2
ate Forma \_) 3 afg 1984 11
Decode @
s 4 af 1985 17
Dedupe (3@ 9
Extract @ 5 afg 1986 18
Fill @ 6 afg 1987 27
Filter @ 7 afg 1988 40
h @
Sather ‘) 8 afg 1989 18
Header (2

9 afg 1990 20

3

If

a

1N afn 1991 21
EEmail us questions/feedback

In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case. You don't have to click a 'run’
button.
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KA
Case ® KN
E Q Filter columns
{ v country

ime
bcg_vacc

1 of 3 columns sele

Change case td; Upper case

Change the case in the selected column(s).

Data  Warnings Info  Com ¢ *

3 cols x 5,780 rows
EE."_;; E% f © Show first 10rows ~

ountry time beg vacc

1 1982 10

2 1983 10

You can create a sequence of transforms to perform complex manipulations.

Jvaccination,cw Y Case v Filter y Sort

3 wls x 5.8k ows 3 cols x 5.8krows 3 cols x4.5krows 3 cols x 4.5k rows

Some transforms require more than one input dataset. For example, to stack two datasets,

one on top of the other:

e Select File>New to start again. Don't save the changes.

¢ Drag two data files onto the Center pane.

e Select both input items (by dragging a box around them or using ctr1+click).

e Click the Stack transform button (you may need to scroll the Left pane to see the
button).
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

= Py R A -
Insert G vaccination.csv @ ‘o i
Interpolate File: ndy\Desktop\waccination.csv ...
e Type: Delimited text b
N Delimiter: Automatic -
_ Quoting:  Automatic o
Join
Encoding: Automatic -
Laokup —
) Ignore: First 0 row(s) -
NEW LD - .
vaccination.csv W has header
MU C i
— 3 ools x 5.5k rows v trim whitespace
rad . . .
: v simplify whitespace
Al v ignore emply rows
Remave Cols watch file
R € Co Meta info: Mot added =
Rearder C Alias: vaccination
Replace

Data  Warnings  Info  Com 4 ¥

accination2.csv 3 cols x 5,780 rows

C B F © showfisti0rows -
country time bcg vacc

1 afg 1982 10

3 ools x 4.5k rows

2 afg 1983 10

3 afg 1984 M

—_— 4 alg 1985 17
(_ Stack @
f 1986 18
Stamp @~ 5 afg =

EEmail us questions/feedback

The tables are now stacked one on top of the other in a new dataset item. You can choose
to match the columns by Header name or Column number.
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E Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - o X
Eile Edit View Licensing Help
DERE v AR E @  rHowDol?

Insert @ = Stack | @ (:P ?c
@ Align calumns tjé. Header name ) b
Merge inp ta pof another.
@ |'Drde e vertical positions of the input
Javaseript (3 daglEts
T @ / Data  Wamings Info  Comm 4 *
Lo @ 3 cols x 10,258 rows
Heweo I8 vaccination.csv LB/ @ D R0 O e
Num Format (&) country time bog vace
Pad @ 3 mls x 5.8k rows 1 ﬂfg 1982 10
Pivot @ 2 afg 1983 10
Remaove Cals (&) Stack 3 afg 1984 11
Rename Cols (&) 4 ok 4 lafg 1985 17
Reorder Cols (3 5 alg 1986 18
Regiace (@ 6 afg 1987 27
Row Num (@ vaccination2.csv
sample @ e s 7 afg 1988 40
Slice @ g afg 1989 28
Sort @ 9 afg 1980 20
splitcol (@ 10 afg 1991 21
Split Rows (&
Spread @ Last 10,248 rows not shown
Stack &)
Stamp @~

EEmail us questions/feedback

Note that the vertical (Y) position of the inputs affects the order the datasets are stacked.
Try swapping the two inputs around and re-select Stack to see the affect.

Any changes to input files will be automatically read in. Any changes to input datasets or
transform options will be automatically propagated 'downstream’.

To export your transformed dataset to a file or the clipboard, view it in a local editor or see it
with whitespace displayed, click on the appropriate button in the Right pane.
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Stack @ E Z

Align columns by: Header name v

Merge input datasets one on top of another.
Orders by the vertical positions of the input
datasets.

Data = Warnings Info Comm * »

Show first 10 rows ~

You can also add an output item to automatically write a dataset to file whenever it
changes.

& Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)* - ] *
File Edit View Licensing Help
DERE v QAR FH @  rHowDol?

r wA
Rename Cols (&) Stack (@) = o
Reorder Cols (%) Align columns by: Header name ¥
= Merge input datasets one on top of another.
Repl [/ .
pEcs, O rders by the vertical positions of the input
Row Mum (@ datasets
Sample (@ Data  Wamings Info  Comm ¥ *
slice & 3 cols x 10,258 rows
sot @ BE S @  showficti0rows ~
vaccination.csv -
splitCol @ country time |beg_vacc
Split Rows (@) 3 oole x 5.8k rows 1 afg 1382 10
Spread (@ 2 afg 1983 10
Stack @ Stack 3 afg 1984 M
Stamp @ 4
swots © 3 cols x 10.3k rows ol =) LR
= 5 afg 1986 18
Substitute (%)
- 6 afg 1987 27
@ vaccination2.csv
Summary (3 7 afg 1988 40
3ok x 4.5k rows
Total @ 8 afg 1989 38
Transpose (%) 9 afg 1990 30
Unique @
i ol 10afg 1991 21
Units &
Whitespace (& Last 10,248 rows not shown
»  Qutput

(: Ter File :@,

=1Email us questicns/feedback

You will be asked for a file to write to. You can choose amongst CSV, Excel, HTML, JSON,
Markdown, Plain text, TSV, vCard, XML and YAML file formats. Select CSV file.
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File name: | output.csv

Save as type: |(CSV file (*.csv)

Excel file (*

Your dataset will then be written to this file every time it changes.

& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - O X
Eille Edit View Licensing Help

ODB8E v« A Q3 @  *HowDon

= output.csv @ ?C E
File: wndyhDesktophoutput.csy ..
Type: Delimited text b
Delimiter: Comma () *
Quoting: As needed v
Line endings: Automatic ¥
Encoding:  UTF-8 ¥
N ' Byte Order Mark

Split Col vaccination.csv . .
Write mode: Owerwrite -

plit Row 3 cols x 5.8K rows .
Alias: output

Sp

Data  Wamings Info  Conm 1 *
3 cols x 10,258 rows
C L% f &> Show first 10 rows ¥

country time bcg_vacc

9 Stack

3 cols x 10.3k rows

output.csv
3 cols x 10,3 rows

1 afg 1982 10
J\raccinalionz_csv

2 afg 1383 10

3 cols x 4.5% rows

3 afg 1984 1

4 afg 1985 17

5 afg 1986 18

6 afg 1987 27

7 afg 1988 40

g afg 1989 38

.,
@
a
L

EEmail us questions/feedback

You can also specify the Delimiter, Quoting, Encoding, Line endings etc for your CSV files
in the Right pane.
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output.csv @ Eﬂ
File: \andy\Desktop\output.csv
Type: Delimited text v
Delimiter: Comma (,) v
Quoting: As needed v
Line endings: Automatic v
Encoding:  UTF-8 v
v Byte Order Mark

Write mode: Overwrite v
Alias: output

You can save your transforms to a . transform document to use again with File>Save.
Have a play!

Tips:

e Check the show advanced check box in the Right pane to see all the available
transforms.

e You can also paste in data from the clipboard (for example, a table from a web page or
Word document).

e The Compare Cols, Filter, If and Sort transforms take account of dates, numbers and
text. You can define what date formats to recognize in the Preferences window.

e New columns are always added to the right of a dataset.

e Comparisons of text are always sensitive to case, unless stated otherwise. E.g. "CASE",
"case" and "Case" are treated differently.

e Comparisons of text are always sensitive to whitespace (e.g. spaces and tabs), unless
stated otherwise. You can use the Whitespace transform to remove leading and trailing
whitespace.

e The contents of input and output data files are not saved in Easy Data Transform, only
their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common ('key') column.

¢ You can insert a new transform between existing items by selecting the connection
between the items and then adding the transform.

e To be more productive with Easy Data Transform see expert tips.
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We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.
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2 Reference
2.1 User Interface
211 Main window
The Main window comprises:
¢ Main menu
e Tool bar
o Left pane
o Center pane
¢ Right pane
e Log pane
e Status bar
Main menu
Tool bar Left pane Center pane Right pane
Easy Data Trageform v1.23.0 - Chdataglinsformiproductitrunkhelpidatatcovid trinsfiorm (licensed to Oryx Digital Lid) x
Edit View ficensing Help
DEGEywyw~ 009 H @ rHwbDen
| Remave C 7 results. csv + Lo il === I
| 3 (?J Qutput to file
| : File: ranstonproduct trunkbelphdatatresults cov |
| & Type: Dielimited teut =
| @ Delimiter  Comema () -
| ® Cuoting As needed b
| ® Line endings: Automatic v
® Encoding:  UTF-8 -
I ® v Byte Order Mark
| ® . Write modde: | Overwrite -
o e olup ve Unigue | Reovecols | L v wiite header
I (J e : .‘: = B Alias: results
| f: g ST Data  Wamings Info  Comment  Details
& E— 3 cols x 206 rows @ Wiritten)
=N pBZeF Y M
' cases deaths  Lookup countriesAndTerrit...
: 1 2469 72 Afghanistan
r 2 789 31 Albania
a ,E: 3 4295 459 Algeria
Tran @ 4 747 44 Andorra =
T . @5 E G SEmail us questionseedback
Status bar Input Transform Output
You can split the Right pane onto a separate monitor (if available) by selecting View>Two
Screen Mode.
2.1.2 Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what

Easy Data Transform
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is selected in the Center pane.
2.13 Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.

2.1.4  Right pane

The Right pane shows details of an input, transform or output item you have selected in the
Center pane.
2.15 Log pane

The Log pane shows a text representation of processing on the current .transform file. It
shows a maximum of 5000 rows.

e Click the X button to clear all text in the pane.

e Click the =l button to select all text in the pane.

e Click the  button to copy selected text in the pane to the clipboard.

¢ Select View>Log (or the corresponding status bar button) to hide/show the pane.

2.1.6 Preferences window

General tab

Check give option to disable outputs when opening a .transform file if you want the
option to disable any outputs with write mode overwrite or append when you open a file,
preventing accidentally writing over existing files. Note that this check is never made when
using the -cli command line argument.

Check use native file windows to use the native Windows file open/save windows.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set At start-up depending on what you want to happen when Easy Data Transform starts.

Set User interface theme to Automatic follow the theme of the operating system or
override it by setting Light or Dark. This is only available if your operating system supports
a dark theme. Changing User interface theme does not update the Center pane colors. You
can also toggle between themes using a keyboard shortcut.

Set Tool bar icon size to the size of the icons you wish to display in the tool bar.
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Set Maximum memory usage to the maximum amount of memory that you want Easy
Data Transform to be allowed to use. If this limit is exceeded the program will try to exit
cleanly.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing. Setting the value to 0 is generally not
recommended, as this means that every single click in the Right pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the ctr1 key while moving the mouse wheel to switch between
zoom and scroll. Hold down the a1t key while moving the mouse wheel to switch between
up/down and left/right scroll.

User interface font shows the font used for the application user interface, apart from data
tables (see below). Click Choose... to choose a new font. Click Default to set it back to the
operating system default.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to
choose a new font. You might prefer a monospaced (fixed width) font such as Consolas,
Lucida Console or Courier New. Click Default to set it back to the operating system default.

The Locale language and country setting affects how some numbers and dates are
displayed. Consequently it may an affect on some transforms. It does not change the
language of the user interface, which is English only.

Set Supported date formats to the date formats you wish to recognize. List the date
formats in order of preference, with the most likely to be used first.

Input Extensions tab
Set the default file types corresponding to input file extensions.

Click in the Extension column and type to change an input file extension. The text will be
trimmed of whitespace, converted to lower case and any ".' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an input file extension.

Click Add to add a new input file extension.

Click Remove to remove the selected input file extension(s).
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Click Default to set the input file extensions back to the default setting.

The order in which input file extensions are shown is not significant.

Output Extensions tab
Set the default file types corresponding to output file extensions.

Click in the Extension column and type to change an output extension. The text will be
trimmed of whitespace, converted to lower case and any ".' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an output file extension.

Click Add to add a new output file extension.
Click Remove to remove the selected output file extension(s).
Click Default to set the output file extensions back to the default setting.

The order in which output file extensions are shown is not significant.

Colors tab

Select a Color scheme for the Center pane. A Preview is shown below. Choose Custom to
choose your own color scheme.

2.2 Input
2.2.1 Inputdata

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also
need to add a sheet name, e.g. '‘MySpreadsheet.xlsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:

e delimited text file (e.g. CSV or TSV) with various delimiters
e Excel .xlIsx or .xls
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e fixed width
e Plain text
e JSON

e vCard

o XML

You can select the input item in the Center pane and change any related options in the

Right pane.

vaccination.csv (f: E EG
@ Input from file.

File: \Desktop\EDT data\CSV\vaccination.csv ...
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v

Ignore:  First O row(s)
V' has header
V' trim whitespace
V' simplify whitespace

V' ignore empty rows

watch file
Meta info: Not added v
Alias: vaccination
Data Warnings Info  Comment 4
3 cols x 5,780 rows @) Read

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Input Extensions tab of the Preferences window.
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For text files Easy Data Transform will treat crLF, LF or cr control characters as line endings.

Easy Data Transform will make an intelligent guess at the:

column delimiter and quoting for delimited text files (e.g. comma)

e column widths for fixed width text files

¢ text encoding for text files (e.g. UTF-8)

e presence of a header row in the data

But you can also do this manually by selecting the input item and changing the Delimiter,
Columns, Encoding and has header fields in the Right pane.

Set Ignore to the number of rows you want to skip before you start inputting. Note that
this takes place before any empty rows are removed by Ignore empty rows.

Set Format to Long (more rows) or Wide (more columns) depending on how you want
to treat arrays/repeat values in JSON or XML.

Check trim whitespace to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to:

e Replace any tabs or line feeds within data values with spaces.

e Replace non-standard spaces (such as non-breaking space, thin space etc) within data
values with spaces.

e Remove carriage returns within data values.

Check Ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Check Ignore empty columns to remove any columns that have only empty values
(whitespace is not considered empty). Header values are ignored when deciding if a column
is empty.

Check watch file if you want the file to be automatically reloaded every time that Easy Data
Transform detects that it has been changed (which will then update everything
‘downstream’).

Use Meta info if you wish to add some meta information about the input dataset, e.g. the
name of an input file or the date it was created.

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.
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To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

Check the show advanced checkbox in the Left pane to see all available transforms.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform ‘upstream’ of it
changes.

Use Comment to record any notes that might be useful to a colleague or your future self.

2.3.2  Calculate

Description
Performs a calculation on 1 or 2 columns and creates a new column.

Examples
Round a column of numbers to the nearest integer:
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date elo1

1 1920-09-26 1503.947
2 1920-10-03 1503.42

3 1920-10-03 1503.42

V

Calculate fj} @ Eg

@ Perform calculations on 1 or 2 columns to creat...

Value 1:  elol v
Operation: Round v
date elol Round(elo1)

1 1920-09-26 1503.947 1504
2 1920-10-03 1503.42 1503

3 1920-10-03 1503.42 1503

Divide a column of numbers by 100:
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Percentage

1 100.0

2 95.2

3 45.3

4 15.6

Calculate fj} Ei'

@ Perform calculations on 1 or 2 columns to creat...
Value 1: Percentage v
Operation:  / Divide v !
Value 2 type: Constant v
Value 2: 100.0

'

Percentage Percentage/100.0
1 100.0 1
2 55 0.952
3 45.3 0.453
4 15.6 0.156

Multiply 2 columns of numeric values:
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ItemID Quantity Cost
1 HG89397834 1 99.00
2 LK02384030 4 9.95
i
i 3 HG99200444 2 7.95
Calculate QG @ Eg
@ Perform calculations on 1 or 2 columns to create a ne...
Value 1: Quantity v
Operation:  * Multiply v
Value 2 type: Column v
Value 2: Cost v

'

ItemID Quantity Cost Quantity*Cost
1 HG89397834 1 99.00 99
2 LK02384030 4 995 398
3 HG99200444 2 795 15.9

Add a days column to a date column:
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Start Duration
1 31/12/2019 7

2 01/01/2021 14

3 07/01/2021 1

v

Calculate ff @ Eg
@ Perform calculations on 1 or 2 columns to create a ne...
Value 1: Start v
Operation:  + Add v
Value 2 type: Column w
Value 2: Duration v

Start Duration Start+Duration
1 31/12/2019 7 7/1/2020
2 01/01/2021 14 15/1/2021
3 07/01/2021 1 8/1/2021

Calculate the difference in days between 2 date columns:
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Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

Calculate B FE

@ Perform calculations on 1 or 2 columns to create a ne... !

Value 1:  End v

Operation: - Subtract v

Value 2 type: Column v t

Value 2: Start v I
Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

Inputs
One.

Options

e Set Value 1 to the first column of values you wish to operate on.

¢ Set Operation to the operation you wish to perform.

e Set Value 2 type depending on whether you wish to use a single value or a column of
values for the second value (binary operations only).
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e Set Value 2 to the second column of values or constant value you wish to operate on
(binary operations only).

Notes
¢ The following operations are supported.
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Operation

+ Add

- Subtract

* Multiply
/ Divide

A Power

%
Modulus

Abs

Ceiling

DayOfWee
k

DayOfMo
nth

DayOfYear

Decremen
t

Floor

Value1 Value2
Number Number
Date Integer
number
Number Number
Date Integer
number
Date Date
Number Number
Number Number
Number Number
Integer Integer
number number
Number N/A
Number N/A
Date N/A
Date N/A
ate N/A
Number N/A
Date N/A
Number N/A

Notes
Numerical addition.

Adds days to the date.

Numerical subtraction.

Subtracts days from the
date.

Days the date in Value 1
is after the date in Value
2 (negative if before).

Numerical multiplication.
Numerical division.

Column 1 to the power
Column 2 (col1w2),
Remainder after Value 1
is divided by Value 2.
The absolute value.

The smallest integer that
is not less than the value.
Day of the week, from 1

= Monday to 7 = Sunday.

Day of the month, from 1
to 31.

Day of the year, from 1 to
366.

Subtract 1.

Subtract 1 day.

The largest integer that is
not greater than the
value

Examples

1.2 + 3 =4.2
31/01/2021 + 7 = 07/02
1.2 - 3 =-1.8
31/01/2021 - 7 = 24/01
31/01/2021 - 24/01/202
24/01/2021 - 31/01/202
1.2 * 3 = 3.6

1.2 / 3 =20.4

1/ 0 = Error

1.2 ~ 3 =1.728

2~ =3 = 0.125

7% 2 =1

7 % 0 = Error

Abs( 1.2 ) = 1.2

Abs( -1.2 ) = 1.2
Ceiling( 1 ) =1
Ceiling( 1.2 ) = 2
Ceiling( -1.2 ) = -1
DayOfWeek ( 31/01/2021
DayOfWeek ( 01/02/2021
DayOfMonth ( 31/01/2021
DayOfMonth ( 01/02/2021
DayOfYear( 01/02/2021
DayOfYear ( 31/12/2021
Decrement( 1 ) = 0
Decrement ( -1 ) = =2
Decrement( 1.2 ) = 0.2
Decrement ( 31/01/2021
Floor( 1 ) =1

Floor( 1.2 ) =1
Floor( -1.2 ) = =2
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e Whether values are interpreted as number, dates or text depends on Supported date
formats and Locale in the Preferences window.

e To concatenate text in different columns use the Concat Cols transform.

To compare 2 columns use the Compare Cols transform.

For logical operations use the |f transform.

For operations on rows or columns use the Stats transform.

For more complex number/date calculations use the JavaScript transform.

To modify the numerical precision of the results use the Num Format transform.

e To add a new column of values use the New Col transform.

2.3.3 Case

Description
Changes the case of text in one or more columns.

Example
Set names to title case:
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First Last

1 john smith

2 JANE SMITH

Case d} @ E:
® Change the case in the selected column(s).
El Q Filter columns

First
v

Last
v

2 of 2 columns selected |

Change case to: Title case v
First Last
1 John Smith
2 Jane Smith
Inputs
One.
Options

e Check the column(s) you wish to transform.
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¢ Set Change case to to Lower case (e.g. "text"), Upper case (e.g. "TEXT") or Title case (e.g.
"Text").

See also

e Whitespace
234 Chop

Description
Remove characters from the start or end in one or more columns.

Example
Remove leading zeros:
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ID
1 0000001

2 0000002

3 0000003

Y

R A

Chop Cf} ¥ N
@ Remove a number of characters from the start o... |
E Q Filter columns

.JID

1 of 1 columns selected

Length: 6 .
From: Start v
1D
1 1
2 2
3 3
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

¢ Set From to Start or End depending on whether you want to remove characters from the
start or end.

Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract
23.5 Clone

Description

Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.6 Compare Cols

Description
Creates a new column with a comparison of two other columns.

Examples
Compare 2 numerical columns:
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Valuel Value2
1 183.34 926.7

2 7 7
3 -345 -8934
Compare Cols CP E ﬂ
@ Compare the values of two columns.
Column 1:  Value1l v
Comparison: > Greater than ¥
Column 2:  Value2 v

v case sensitive

'

Valuel Value2 Valuel:>Value2

1 183.34 926.7 false

2 7 7 false

3 -345 -893.4 true

Compare 2 date columns:
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Datel Date?
1 7/1/2021  01/01/2021

2 1/1/2021 01/01/2021

3 31/12/2020 01/01/2021

V

Compare Cols tf} L EG
@ Compare the values of two columns.
Column 1:  Datel v
Comparison: >= Greater than equal b4
Column 2:  Date2 v
V' case sensitive

'

Datel Date2 Datel>=Date2

1 7/1/2021  01/01/2021 true

2 1/1/2021 01/01/2021 true

3 31/12/2020 01/01/2021 false

Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2 and the
Comparison operator.

e Check case sensitive to use case sensitive matching for text.
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Notes

e Number, date and text values are treated differently. Any values that can be converted to
a number will be treated as a number. Any values that match the supported date formats
in Preferences will be treated as a date. All other values are treated as text.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e See here for more details on Regular expressions (regex).

See also

e Split Cols
2.3.7 Concat Cols

Description
Creates a new column by concatenating text from existing columns.

Example
Concatenate 'First' and 'Last' columns with a comma between:
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First Last
1 John Smith

2/Jane Smith

K A

Concat Cols d} ECC

@ Concatenate selected columns into a single new...
E Q Filter columns

First
v

Last
v

2 of 2 columns selected

Delimiter: ,

keep empty

First Last First+Last

1 John Smith John,Smith

2 Jane Smith Jane,Smith

Inputs
One.

Options
e Check the columns you wish to concatenate.

e Supply the Delimiter you wish to place between concatenated text (optional). For
example ",".
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e Check keep empty if you wish to keep the delimiter for empty columns.

Notes

e If there is a header, the header of the new column is formed from the header of the
concatenated columns. You can use Rename Cols to change the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the original columns. You can change the
column order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.8 Concat Rows

Description
Concatenate multiple consecutive rows into a single row.

Example
Concatenate every 2 rows to 1:
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sensor datetime value

1 sensor1 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

Concat Rows Cf: @ Ei!

® Concatenate multiple consecutive rows into a si...
Fy

———

Create 1 row from every: 2

sensor datetime value sensor datetime wvalue

1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764

2 sensor1 1/1/18 0:10 541 sensor2 1/1/18 0:10 702

Inputs
One.

Options

e Set Create 1 row from every to N to concatenate every N rows into 1 row.

Notes

e Use New Col if you need to add additional columns before concatenating rows.

e Use Filter if you need to remove rows before concatenating row.

e Use Rename Cols if you need to change column names after concatenating rows.
e The opposite of Concat Rows is Split Rows.
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See also

e Spread
e Concat Cols

2.3.9 CopyCols

Description
Creates one or more copies of the selected column(s).

Example
Copy 2 columns, once each:
First Last
1 John Smith
2 Jane Smith
Copy Cols od e S
@ Copy selected columns.
E] Q Filter columns
First
q | !
Last
VA
2 of 2 columns selected
Copies: 1 .

First Last First Last

1 John Smith John Smith

2 Jane Smith Jane Smith
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Inputs
One.

Options
e Check the columns you wish to copy.
¢ Set Copies to the number of copies you want to make of each checked column.

Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col

2.3.10 Count

Description
Counts the number of occurrences of each item of text in the selected column.

Example
Count unique values in the 'Response’ column.
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Response

1 YES
2 NO
3 NO

4 NO

Count tf} E Q

@ Count the occurences of text in the selected col...

v

Column: Response
Sort by: Count b4
Order. Ascending v

v case sensitive

Response Count Response

1 YES 1
2 NO 3
Inputs
One.
Options

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the Text in the left
column or numerically by the Count in the right column.

¢ Set Order depending on whether you wish to sort Ascending or Descending.
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e Uncheck case sensitive to convert everything to lower case before counting.

Notes

e Date and number values are treated as text.

e Use Rename Cols to change the new column name.
e Use Scale to convert the results to percentages.

See also
e Ngram

e Summary
2.3.11 Cross

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product' or 'cross join'.

Example
Cross 2 small datasets:

letter
B — . letter number
' Clipboard 1A 1
\ 1 col x 3 rows 2A 2
3C
3A 3
' Cross 48
V4 8
2 cols x 9@ rows 5B 2
number 6B g
11 y N Sl
' Clipboard
22— 8C 2
",_\ 1 col x 3 rows
33 9C 3
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Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e |t can create a very large number of rows!

2.3.12 Date Format

Description
Changes the date format in one or more columns.

Example
Change day/month/year to month-day-year:
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Date
1 31/12/2020

2 1/1/2021

3 2/1/2021

L

Date Format \'j’ Z’G

® Change the date format in the selected column(...

IE' Q Filter columns

v Dafte

1 of 1 columns selected

Format from: d/M/yyyy

Format to: MM-dd-yyyy

v

Date
112-31-2020
2 01-01-2021
3 01-02-2021
Inputs
One.
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Options

e Check the columns you wish to transform.

e Supply the existing date format in Format from (see below).

e Supply the new date format in Format to (see below).

¢ The following date formats are supported for input and output:

Format Meaning

d The day as number without a leading
zero (1to 31)

<l The day as number with a leading zero
(01 to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

delclel The long localized day name (e.g.
'‘Monday' to 'Sunday'). Uses the locale to
localize the name.

= The month as number without a leading
zero (1to 12).

L The month as number with a leading zero
(01 to 12)

MM The abbreviated localized month name
(e.g. 'Jan' to 'Dec’). Uses the locale to
localize the name.

MMMM The long localized month name (e.g.
‘January' to 'December’). Uses the locale
to localize the name.

vy The year as a two digit number (00 to 99).

yyyy The year as a four digit number. If the

year is negative, a minus sign is
prepended in addition.
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Notes

e An exact match is expected for the input date. E.g. Format from is yyyy-MM-dd then
2020-12-17 will be converted, but 2020-12-17T14:58 won't. You can extract just the
date part here using Split Col with T as the delimiter.

e Use the correct case for the format (e.g. yyyy-MM-dd, not YYYY-mm-DD).

e The Locale set in the Preferences window is used to decide how the date is represented
(e.g. names of months and days).

¢ You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.

o If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919.

e Warnings are shown in the Warnings tab for values that don't match Format from.

See also
e Num Format

2.3.13 Decode

Description
Convert to/from Base64 encoding, URL encoding, escaped HTML or escaped XML.

Example
Convert <'Hello World!'> to base64 encoding:
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1
1 <'Hello World!"' >

Decode Cf.'-‘ @ :;
@ Convert to/from baseb4, URL, HTML or XML enc...
IE' Q Filter columns

v 1

1 of 1 columns selected

Change: To base64 encoding v

1
1 PCAIZWxsbyBXb3JsZCEnPg==

Type Plaintext Encoded

Based64 <'Hello World!'> PCAdIZWxsbyBXb3JsZCEnPg==
encoding

URL <'Hello World!'> %$3C%27Hello%20World%s21%27%3E
encoding

HTML <'Hello World!'> &1lt; 'Hello World!'&gt;

escaping

XML <'Hello World!'> &lt; &apos;Hello World!&apos; &gt;
escaping
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Inputs
One.

Options
e Check the column(s) you wish to transform.
e Set Change according to how you want to decode/encode the selected columns.

Notes
e This is distinct from text encoding (e.g. UTF-8 vs UTF-16) which is handled on input and
output.

e Use Copy Cols to copy columns before you transform them.
e Data input from XML files and output to HTML and XML files is unescaped/escaped
automatically.

2.3.14 Dedupe

Description
Remove duplicate rows.

Example
Keep the first record for each unique 'Customer Id":
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Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown

89456 10.55 01/10/2020
3 Charlie Jones CO17783 96352 19.95 02/10/2020 i

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones C017783 38746 25.00 03/10/2020]

V

Dedupe d: = D g
@ Remove duplicate rows by matching values in all the selected colu...

o -
El Q Filter columns

MName

v Cgstomer Id.
Product Id

Colst

Date

1 of 5 columns selected

v case sensitive

V

Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

_ 2 Bob Brown 89456 10.55 01/1 UIZ{]EG
Easy Data Transform © 2022 Oryx Digital Ltd




Reference

Inputs
One.

Options
e Check the column(s) you wish to look for duplicate values in.
e Check case sensitive to use case sensitive matching.

Notes

e Rows are considered duplicates if they have exactly the same value in all the checked
columns.

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before deduping and Replace to get of other unwanted characters (e.g. whitespace inside
the text).

e When several rows are duplicates, only the top one is retained.

e The Unique transform is a more powerful (but more complex and slower) alternative to
Dedupe.

See also
e Dedupe a dataset
2.3.15 Extract

Description
Extract a length of text in one or more columns.

Example
Extract the first 2 digits from the 'Product Id" column:
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Product Id
1 C13574

2 A89456

13 A96352

y

R Al
Extract ‘ol ¢ N

@ Extract a fixed number of characters from the s...

E El Q Filter columns

Product Id

v

1 of 1 columns selected

Length: 2 -
From: Start v
Offset: 0 =
Product Id
1C1
2 A8
3 A9
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ Set Length to the length you want values in selected columns shortened to.

e Set From to Start or End depending on whether you want to take from the start or end.

¢ If From is Start then Offset is the offset of the first character from the start (O to start
with the first character). If From is End then Offset is the offset of the last character from
the end (0 to start with the last character).

Notes

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before extracting.

e If you want to set a column to a fixed length use Pad and Extract together.

See also

e Chop
2.3.16 Fill

Description
Fill empty cells in selected columns with the next adjacent non-empty cells. The direction is
the direction to fill to (not from).

Example
Fill down:
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Country Area City
1 Country 1 Area 1‘Cityr 1
2 City 2
3 City 3
4 Area 2‘City 1
5 City 2
Fill } & B 27

@ Fill empty cells in selected columns from adjace...
E] Q Filter columns

J Ct::unfr:.-.r.

Area
v

v

3 of 3 columns selected
Direction: Down v

V

Country Area City

1 Country 1/Area 1 City 1

2 Country 1 H City 2

3 Country 1[{Area 1 City 3

4 Country 1 /Area 2 City 1

5 Country 1 /Area 2 City 2
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Inputs
One.

Options
e Check the column(s) you wish to fill.
¢ Select Direction depending on the direction you wish to fill to.

See also
e Unfill
2.3.17 Filter

Description
Removes rows based on number, date and text values in selected columns.

Examples
Remove rows where all values are empty.

- KA
Filter (f’ ¢ N
® Filter rows by text, date or numeric values in sel...

@ @ E;Elb @I%j X | |Keep ¥ | Matching any |

Column Op. Value
1 <Any> v |l= ¥

Keep only rows where the 'Tax' value is greater than 0 and the 'Country’ value is 'US".

Filter tf' E i
@ Filter rows by text, date or numeric values in sel...

® X E & X Keep ~ Matchingall ¥

Column Op. Value
1 Tax ¥YI|> ¥|0
2 Country ¥l= ¥ |US
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Inputs
One.

Options

e Click the ® button to add a new filter criteria.

o Click the ® button to delete the selected filter criteria.

e Click the B button to copy terms to the clipboard.

e Click the & button to paste terms from the clipboard.

e Click the X button to clear all terms.

¢ Select Keep if you want to keep matching rows and Remove to remove matching rows.

e Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching
any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare. You can use a column variable.

e Check case sensitive to use case sensitive matching for text.

e Check disable filtering to turn off filtering. If sampling is disabled, the transform does
nothing.

Notes

e A filter row is ignored if the Value column is empty , except when Op. is Equal to, Not
equal to, Matches regex or Doesn't match regex.

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

o All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

¢ See here for more details on Regular expressions (regex).

¢ Y can use Subtract to see rows removed by filtering if there is unique key column.
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Subtract

14 cols x 585 rows

]

orders.csv rows removed
by filtering

/]

9

14 cols x 830 rows

o Filter

14 @ls x 245 rows

e If you are pasting in filter terms, the format expected is comma delimited text with 3
columns.
o The first column is the 0-based index of the Column drop-down list.
o The second column is the 0-based index of the Op. drop-down list.
o The third column is the Value.
For example, pasting in:

0,0,YES

Will add:

Column Op. Value
1 <Any> ¥ Ilc ¥ |YES [

You can also try copying terms to the clipboard and pasting into a text file to see the
format. If you only paste in 1 column of text, it will be assumed to be a list of Value. You
can, of course, use Easy Data Transform to create the appropriate filter terms and paste
them into memory.

See also

e Compare Cols
e Slice
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2.3.18 Gather

Description
Gather multiple columns into new key and value columns. Also called unpivot, long pivot or
group by.

Example
Gather 'Q1', 'Q2', 'Q3" and 'Q4' columns into 1 column.
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2 Bob East 45 79 8 33

v

Gather 05 @ Eg

@ Gather selected columns into key and value col...
E] Q Filter columns
salesman

drea

v
v ¥

.

7

4 of 6 columns selected

Key column name: Quarter

Value column name: Amount

v

salesman area Quarter Amount

1 Alice North'Q1 11.3
2 Alice NUHE
3 Alice North/Q3 443




Reference

Inputs
One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based
on the names of the columns selected.

e Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e You can merge the value and key columns into a single column with Concat Cols.

e The opposite of Gather is Spread.

See also

e Split Rows
2.3.19 Hash

Description
Perform one-way hashing on selected columns.

Example
Compute the MD5 hash of <'Hello World! '>:
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1
1 <'Hello World!">

‘

R Al

Hash g ¢ N i'

() perform a one-way hashing.
E| Q Filter columns

vr‘l

1 of 1 columns selected

Algorithm: MD5 v
1

1 f0d946347af462d489af835d3737fe70
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Type Plaintext Secret Hashed
SHA1 <'Hello World!'> 4a700d8555aae497cc
SHA-256 <'Hello World!'> 2c6139a5d874b9626e
SHA-512 <'Hello World!'> 23728b865af0£f17bb9
SHA3-256 <'Hello World!'> 0701263723cdbdflle
SHA3-512 <'Hello World!'> 6lcbf6flle864af592
e 25E <'Hello World!'> 1245dd8df9de650496
Keccak-512 <'Hello World!'> 2741b7ddfe0d4cd726
MD5 <'Hello World!'> £0d946347af462d489
HMAC-MD5 <'Hello World!'> ABC123 5940ca9b5f2b47ael9
HMAC-MD5 <'Hello World!'> abcl23 b185£719143d6380cc
Inputs
One.
Options

e Check the column(s) you wish to transform.

¢ Set Algorithm to the hashing algorithm you wish to use

e Set Secret to the secret key you wish to use (HMAC-MD?5 only). The default value is
randomly generated.

Notes

e There is no known way to reverse these hashes.

e As the chance of 2 different inputs generating the same hash value by chance (a
‘collision’) is infinitesimally small, hashing can be used to anonymize data or to help find
duplicates of long data values.

e The MDS5 algorithm is now considered weak as a cryptographic hash. But remains suitable
for other non-cryptographic purposes.

e Use Copy Cols to copy columns before you transform them.
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2.3.20 Header

Description
Move rows from the top of the dataset into the header.

Example
Append the first row to the header:

Sample Sample Sample

1 1 2 3
2 22334 2389 1935

3 82.2 5059 93451

y

Header d} Ei
@ Move rows to the header.
Top rows to move: 1 =
Existing header. Append v
Delimiter: -

'

Sample-1 Sample-2 Sample-3
1 22334 23.89 19.35

2 82.2 5059 93451

Inputs
One.
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Options

e Set Top rows to move to the number of rows you want to move from the top dataset
into the header. Setting it to 0 means the transform does nothing.

¢ Set Existing header to Overwrite to ignore the existing header values and Append to
add to the existing header values.

o Set Delimiter to any text you want to put between column elements. It can be left empty.
Ignored if Existing header set to Overwrite and Top rows to move set to 1.

Notes

e Empty cells are ignored.

¢ You can Sort and Filter your dataset to change the top rows.

e You can add the header from one dataset to another dataset using Stack.

See also
e Headers
2.3.21 |f

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Examples
Add a new column based conditionally on 'Payment’ and 'Currency’ columns:

Easy Data Transform © 2022 Oryx Digital Ltd



Reference

Payment Currency

1 462697 USD
2 64754 USD

3 6353.12 GBP

y

’ FEL

@ Create a new column with values conditional on value...

New column name: Convert

@ESEIF @DAND T L X

Logic Column Op. Value
11IF Currency ¥ |= ¥ USD
2 THEN= No
3 ELSE IF  Currency ¥ |= ¥ |GBP
4 AND Payment ¥ >= ¥ 1000
5 THEN= Yes
6 ELSE= No

v case sensitive

\

Payment Currency Convert

1 4626.97 USD No
2 64754 USD No

3 6353.12 GBP Yes

If the h1 value is 1 use the value of the h2 column, otherwise use the value of h3 column:
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h1 h2 h3
1A A 1
2B B 2
3cC C 3
4d D 4
i * FECl

@ Create a new column with values conditional on oth...

New column name: If

®ESEIF (HDanp ™ L X

Logic Column Op. Value
1IF h1 ¥ i = ¥ §h2)
2 THEN= $(h2)
3 ELSE= $(h3)

v case sensitive

v

h1 ha h3 If
1A A 1A
2B B 2B
3c C 3 3
4d D 4 4
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Inputs
One.

Options

e Click the ®ELSE IF button to add a new IF/ELSE IF.THEN condition.

e Click the ®AND'button to add an AND to the selected IF/ELSE IF..THEN.
e Click the ® button to delete the selected IF/ELSE IF. THEN/AND.

e The Logic column shows the type of row.

e Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

e Check case sensitive to use case sensitive matching for text.

Notes
e The IF, THEN and ELSE values can use column variables, as in the second example above.
e You can simulate OR with multiple IF statements. For example:

IF x =1 O0OR Yy =2
THEN 3

Is equivalent to:

IF x =1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

¢ All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also
e Lookup

Easy Data Transform © 2022 Oryx Digital Ltd



Reference

2.3.22 |nsert

Description
Append/prepend text to one or more columns.

Example
Add 'ID-' to the front of a column of text:
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1D
1230933
2 223441
3 323412
Insert CF E g

@ Append/prepend text in the selected column(s).
|E| Q Filter columns

\;ID

1 of 1 columns selected
Insert: 1D-
At: Start

v

ID
1/ID-230933
2 1D-223441
31D-323412
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ In Insert put the text you want to insert. You can use a column variable.
¢ In At put the position you want the text inserted.

Notes
¢ You can use Whitespace to remove whitespace before inserting.

See also

e Pad

o Extract
2.3.23 Interpolate

Description

Interpolate values for a dataset based on numerical sample-value pairs in another dataset
and puts the result in a new column.

Example

Interpolate time and temperature datasets for sensors A and B with different sampling
frequencies:

KA
time A temperature A Interpolate o '
1 0.0 1.134 @ Create a new column in the top dataset by inter...
Top sample column: time A M
Bottom sample column: time B v
3 20 2773 Bottom value column:  temperature B b
e sensor-A.csv
4 Q'OEO Interpolation type: Linear Py
2 cols X 6 rows
5 40 3333 /
time A temperature A Interpolate temperature B
6 2874 Interpolate 1. 00 1134
P >
B 3 cols x 6 rows 1.0 778
time B temperature B 2 - 3
1 00 0.000 3 20 2773
sensor-B.csv
2 20 4 30 5.039
2 cols x 4 rows
3 40 2697 5 40 ESES
4 60 6 5.0 2.874
Inputs
Two.
Options
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¢ Place the dataset you want to modify as the top input and the dataset you want to
sample values from as the bottom input.

¢ Select Top sample column for the column whose values you wish to sample.

¢ Select Bottom sample column for the column that matches the top sample column in
the bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Interpolation type to the type of interpolation you wish to use.

Piecewise interpolation (image from Wikipedia)
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Linear interpolation (image from Wikipedia)

Notes

e If your sample is below the first sample in the bottom dataset, the first value will be
returned.

e If your sample is above the last sample in the bottom dataset, the last value will be
returned.

e Easy Data Transform will try to guess sensible default values for Top sample column,
Bottom sample column and Bottom value column based on column contents.

e If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

e Messages are shown in the Warnings tab for non-numeric values in either dataset.

e Messages are shown in the Info tab for Top sample column outside the range of values
in Bottom sample column .
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See also

e Lookup
e Join

2.3.24 Intersect
Description

Keep only rows from the top dataset with key values that are present in the lower dataset.

Example
Keep rows in the top dataset that also have their ids in the bottom dataset:

Id  First Intersect « = 53
1 001 Alice @ Keep only rows from the top dataset whose key value... |
intersect-1.csv Top key column:  Id v

2 002 Bob * (V)
X Bottom key column: ID
3| 003 Charlie 2 cols x 4 rows /

v

4 004 Dwayne

Intersect 4 _met
(/] V sl |1 001 Alice

2 cols x 2 rows 2

ID
intersect-2.csv

1001 ek @

1 col X 2 rows

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

e Check case sensitive to use case sensitive matching for keys.
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Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e If the first input has a header, this will be used for the output.

e All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract
2.3.25 Javascript

Description
Create a custom transform using JavaScript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without
programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the JavaScript transform. It allows you to
write the body of a JavaScript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

JavaScript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle numbers, dates and text.

Examples
Multiple the value in column ‘items' by the value in column 'item price":
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items item price

1 1 11.45
2 5 0.95

2 2 9.95

Javascript f:f’ Eﬂ

@ Script your own custom transform in Javascript.

New column name: cost

Javascript:

return $(items) * $(item price);

items item price cost
1 1 11.45 11.45
2 5 095 475
3 2 995 199

To concatenate 'last' and 'first' columns with a comma and a space:

return $(last) + ', ' + S(first);

To calculate the biggest of columns 'v1' and 'v2"
return Math.max( $(vl), $(v2) );

To determine whether phone numbers in the '‘phone_num' column are valid using a regular
expression:

const validPhoneNum = /"~[\+]2[(]?2[0-9]1{3}[)12[-\s\.12[0-9]1{3}[-\s\.]12[0-9]1{4,6}$/;
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if ( validPhoneNum.test( $(phone num) ) )
return "valid";

else
return "invalid";

To replace the last comma in the 'Location’ column with a '} using a regular expression:

return $(Location) .replace(/(.*), ([~ 1*)S$/, '$1;$2");

To calculate the number of years difference between JavaScript compatible dates in column
1 and column 2:

return new Date( $(1) ).getFullYear() - new Date( $(2) ).getFullYear();

To calculate the number of milliseconds between a datetime in the 'datetime’ column and
1st Jan 2000:

return new Date( $(date) ) - new Date( "2000-01-01T00:00"™ );

To calculate the number of whole days difference between a date in the 'created' column
and today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) / ( 1000*60*60*24 ) );
To use the value of the 'n' column if it is a number and O if it isn't:

if ( isNaN( S$S(n) ) )
return 0O;

else
return $(n);

To reverse the text in the 'key' column:

var a = $(key);
var newString = "";
for (var 1 = a.length - 1; i >= 0; i--) {

newString += ali];
}

return newString;
To convert meters to feet using a function:

function metersToFeet ( x )

{
return 3.28084 * x;

}

return metersToFeet ( $(meters) );

Inputs
One.
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Options

e Enter your script into the JavaScript field. The script should be the body of a JavaScript
function.

e Select a column from Insert variable to add that column variable into the JavaScript field
at the current cursor position.

e Click the Evaluate button to evaluate your JavaScript expression over every row and show
any errors.

Notes

e The JavaScript transform is calculated every time:
o The Evaluate button is pressed.
o The JavaScript transform item is unselected in the Center pane and script changes

have been made without the Evaluate button being clicked.

o An item upstream of it changes.

e A numeric value is passed as a JavaScript number variable. true and false are passed as
a JavaScript boolean variable. Everything else is passed as a JavaScript string variable.

e An empty cell is passed as an empty JavaScript string variable (""), not nu11. To test if the
"v" column has a blank or empty value:

if ( $(v).length === 0 )

{ // empty cell

élse if ( String( $(v) ).trim().length === 0 )
{ // blank cell

}

e Numeric values should use dot ('.") as the decimal separator and have no group separator.
E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not, regardless of the locale set in the
Preferences window. You can use the Num Format and Replace transforms to put
numeric data in the correct format before processing a JavaScript transform.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e The JavaScript Date() object evaluates to the number of milliseconds since 1 January 1970
UTC.

¢ Date values passed to JavaScript Date() objects should be in ISO ('yyyy-mm-dd') format,
e.g. '2020-01-31' (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should merge
them first, e.g. using Join.

e The JavaScript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.
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e JavaScript running in Easy Data Transform is not 'sandboxed' and has the same privileges
as the Easy Data Transform executable. However the JavaScript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from JavaScript sent in a .transform file.

e JavaScript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.

e Warnings are shown in the Warnings tab for:

o JavaScript syntax errors
o Ambiguous column references
e For simple arithmetic operations on numbers and dates use the Calculate transform.

See also
¢ Find the difference between dates/datetimes

2.3.26 Join

Description

Merge two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs. The bottom dataset (by vertical position) is joined to the right of the
top dataset.

Example
Join two datasets side-by-side using the 'ID' columns:
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Join (f EC
@ Merge 2 input datasets side by side using com...
Top key column: ID v

include top non-matching row
Name ID DOB

Bottom key column: ID A
1/John Black 001 1966-07-01

2 Paul White 002 1973-03-11 el © e 202

3 cols x 4 rows

include bottom non-matching

/

Join

3 Jill Green 003 1977-12-30

4 Ahmed Ali 004 1980-11-05

5 cols x 4 rows

D DOB

ID  Department Level

1 001 Engineering 1

\g
/

: ‘ details.csv
2| 004 Marketing H 9 Name Department Level
. ) 3 cols x 4 rows
3 003 Engineering 2 1John Black 001 1966-07-01 Engineering 1
4 002 Sales 2 2 Paul White 002 1973-03-11 Sales 2

3 Jill Green 003 1977-12-30 Engineering 2

4|Ahmed Ali 004 1980-11-05 Marketing 1

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select include top non-matching rows if you want to include in the output any rows in
the top input with no matching value in the bottom input.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.

¢ Select include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input.

¢ Check case sensitive to use case sensitive matching for keys.
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include top non-matching include bottom non- Also known as:

rows checked matching rows checked

No No Inner join

No Yes Right outer join

Yes No Left outer join

Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one on top of the
other (vertically) use Stack.

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

¢ All values are treated as text. You can use Whitespace to remove whitespace before the
join.

o If a key value occurs M times in the first dataset and N times in the second dataset, you
will get M x N rows with this key value. You can use Unique to remove rows with duplicate
key values.

e If you need more than one column for the key, use Concat Cols to create that column.

e Use Row Num to create a unique key column.

e Use Sort to sort the results.

e Use the Cross transform for cross joins.

e Messages are shown in the Warnings tab for keys that occur more than once in either
dataset (duplicates).

e Messages are shown in the Info tab for keys that only occur in 1 of the 2 datasets
(misses).

e Use Subtract to see rows not joined from the top or bottom dataset (the Clone is
necessary to get the correct Y position of the bottom dataset for the Subtract).
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Clone
/]
14 cols x 750 rows
Filter », Subtract Rows not joined
o o from top dataset
11 cols x 87 rows 11 cols x 9 rows
Join
/]
24 aols x 720 rows
Filter Subtract joi
PN ® 1I?u:nr'ursbng:t|-:n|r:’eil .
14 cols x 750 rows 14 cols x 30 rows rom bottom datase

e Cascade multiple joins to join more than 2 datasets.

CLIS LM &f 5. CS

(]

11 ols x 91 rew s

Join

(]

14k =830 mws 28 colsx 22k mw s

24 @l xE30 rows
orders.csv Join
/0

order details... Join

Seals = 2.2k rows 37 cols x 22k row s

° products.csv Join

10eslex 77 mws daeelnzzkmws

12 colsx 29 ows 51 cols x 2.2k mws

° suppliers.csv > Jain

cabe gones.csv

4 eolax 8 rows

See also

¢ Video: How to join Excel files
e Cross

e Lookup

e Interpolate
e Merge datasets
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2.3.27 Lookup

Description
Looks up the values of a column in the top input dataset in the bottom input dataset and
puts the result in a new column.

Example
Lookup category name in a second dataset using '‘Category ID":

Lookup & el
@ Create a new column in the top dataset using values loo...
Top lookup column: Category ID =
Bottom lookup column: Category ID v
Product ID Product Name Supplier ID Category ID Bottom value column:  Category Name v
1 1 Chai 1 1 Bottom values used:  First v
2 2 Chang 1 1 products.csv If no match: Use no match value v
. * 9 No match value:
3 3 Aniseed Syrup 1 2 A a5 E e
4 4 Cajun Seasoning 2 2

5 5 Gumbo mix 2 2 5 LOOkup
5 cols x 5 rows

Category ID Category Name Descript

1  seeEr soft drinks categories.csv Product ID Product Name Supplier; ID Category ID Lookup Category Name
2 2 Condiments sauces, relishes and seasonings e — 1I 1 Chai 1 1 Beverages
3 3 Confections dessers and candies 2| 2 Chang 1 1 Beverages
3] 3 Aniseed Syrup 1 2 Condiments
4| 4 Cajun Seasoning 2 2 Condiments
5| 5 Gumbo mix 2 2 Condiments
Inputs
Two.
Options

¢ Place the dataset you want to modify as the top input and the dataset you want to lookup
values from as the bottom input.

Click Explore Keys... to compare key values in the 2 datasets.

Select Top key column for the column whose values you wish to lookup.

Select Bottom key column for the column that matches the lookup in the bottom
dataset.

Select Bottom value column for the column that contains the values.

Set Bottom values used to First if you want use the first match in Bottom lookup
column and All if you want to use all unique matches.
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¢ Set If no match to Use not match value or Leave unchanged depending on what you
want to do for values in Top lookup column that do not exist in Bottom lookup
column.

¢ Set No match value to the value you want to use for values in Top lookup column that
do not exist in Bottom lookup column when If no match is set to Use no match value.

e Check case sensitive to use case sensitive matching for keys.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column,
Bottom lookup column and Bottom value column.

e Bottom values used is only important if there are duplicate values in the Bottom lookup
column.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the lookup.

e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e Warnings are shown in the Warnings tab for:
o Values that cannot be found in the bottom dataset (misses).
o Values that occur more than once in the bottom dataset (duplicates), if Bottom values

used is First.

See also
o If

e Interpolate
e Join

2.3.28 New Col

Description
Adds a new column, filled with a given value.

Example
Add a new column full of '1' values:
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price

11145
2 095

3 995

New Col Ou @ Eg

@ Add a new column filled with a specified value.

New column name: quantity

MNew column value: 1

price quantity
1 1145 1
2| 0.95 1
3 995 1

Inputs

One.

Options

¢ Set New column value to the value for every cell of the new column. You can leave it
blank for an empty column.

Notes
e New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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See also

e Copy Cols
e Remove Cols

2.3.29 New Rows

Description
Add new rows.

Examples
Add a blank row above every row with an invoice number:
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Invoice Lineltem Value

1 00456 1 150.00

2 2 95.00

3 3 50.0

4 00457 1 845,00

5 2 12.50

New Rows CP E Eg

® Add new rows.
Number added: Same for every row v
Number value: 1 :
As: Blank row(s) v
Location: Above each row v
For: Rows where v
Column: Invoice S
Matches: I= Not equal to =

Value:

v case sensitive

.

Invoice Line ltem Value

|
2 00456 1 150.00
3 2 9500




Reference

Copy each row the number of times in the ‘ltems' column:

Orderld Items

1 12345 0

2 12346 1

3 12347 2

New Rows CP EQ

@ Add new rows.
Number added: Set from a column v
Number column: Items x
As: Copied row(s) v
For: Every row s

v

Orderld Items
1 12345 0

2 12346 1

3 12346 1
4 12347 2
4 12347 2
6 12347 2
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Inputs
One.

Options
e Set Number added according how many rows to add for each existing row.
o Set Number value to the number of new rows to create for each existing row (available
when Number added is Same for every row).
o Set Number column to get the number of new rows to create for each existing row
from a column (available when Number added is Set from a column).
e Set As to add either blank rows or copies of existing rows.
¢ Set Location depending on whether you want new rows added above or below existing
rows (available when As is Blank row(s)).
¢ Set For depending on whether you wish to add rows to all rows or only rows that meet
certain conditions.

Notes

e You can use Calculate or JavaScript transforms to calculate the number for the Number
column. E.g. to subtract 1 from the final number of copies wanted to give the number of
New rows.

See also
e Offset
2.3.30 Ngram

Description
Counts the number of times each sequence of consecutive words appear in the selected
column.

Example
Find ngrams of 2 to 3 word length (bigrams and trigrams) in the '‘Keywords' column.
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Keywords
1 EDT

2 easy data transform
3 Easy Data Transform
4 easy data transformer

5 data transformer

6 EASY,DATA, TRANSFORM

‘

Ngram d’ @ E

@ Count sequences of N consecutive words in the...

Column: keywords v
Minimum N: 1 =
Maximum N: 6 : |

v case sensitive

‘

Keywords Ngrams Words Count
1 easy data transform 3 3
2 easy data transformer 3 1
3 easy data 2 4
4 data transform 2 3
5 data transformer 2 2
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Inputs
One.

Options

e Select the Column you wish to analyze for ngrams.

e Set Minimum N to the minimum number of words in an ngram.

e Set Maximum N to the maximum number of words in an ngram.

¢ Uncheck case sensitive to convert everything to lower case before counting ngrams.

Notes

e Words are made up of letters, digits and apostrophes (). All other characters are treated
as word separators.

e All letters are converted to lower case.

e The output sorted by number of words in the ngram, then the count and then the ngram.
Use a Sort transform to sort it in a different order.

e Use a Replace transform before the Ngram transform to remove/replace any words or
letters you don't wish to analyze.

See also
e Count

e Unique
e Total

e Pivot

o Stats

e Summary
2.3.31 Num Format

Description
Change the number format in one or more columns.

Examples
Set numeric values to 2 decimal places:
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Value

1 1.27239
2 23.52035

3 49.7877

y

Num Format fff} EC

® Change the number format in the selected colu...
El Q Filter columns
Value

v

1 of 1 columns selected

Format: f v

4 )

Precision: 2

use group separator

Non-numeric: Leave v

v

Value
1 1.27

2 23.52

3 49.79

Set numeric to shortest accurate number:
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Value

1 1.2720000

223.0035000

3 4.0787770

'

Num Format o d »¥e

@ Change the number format in the selected colu...
E Q Filter columns

v Value

1 of 1 columns selected

Format: 5 b
Precision: 3

use group separator

Non-numeric: Leave s

v

Value

1 1.272
2 23.0035

3 4.078777
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Format to the new number format (see below).

e For the e, E, and f formats, Precision represents the number of digits after the decimal
point. For the g and G formats, Precision represents the maximum number of significant
digits (trailing zeros are omitted). For the s format Precision is ignored. The following
number formats are supported:

Format Meaning
€ Format as [-]9.9¢e[+]|-]999.
E.g. 1234567.89 is shown as 1.235e+06.
B Format as [-]9.9E[+]-]999.
E.g. 1234567.89 is shown as 1.235E+06.
£ Format as [-]9.9.
E.g. 1234567.89 is shown as 1234567.89.
el Use e or f format, whichever is the most concise.
G Use E or f format, whichever is the most concise.
s The shortest accurate representation for the given

number without exponents.
E.g. 1234567.00 is shown as 1234567.

¢ Check use group separators to include the group separators for your locale. E.g. to turn
1234567 to 1,234,567 for a UK or US locale.

¢ Set Non-numeric according to what you want to do with non-numeric values in
transformed columns. NaN means Not a Number.

Notes

¢ The Locale set in the Preferences window is used to decide how the number is
represented (e.g. group and decimal separators).

e Non-numerical values are ignored.

e You can also use Extract and Pad to change the number of characters.

e Warnings are shown in the Warnings tab for non-numeric values.
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See also
e Date Format
2.3.32 Offset

Description
Moves values in selected columns up or down.

Example
Move the 'v2' values down 1:
v v2
1 1 1
2 2 2
3 3 3
4 4 4
5 5 5
Offset o=z 03¢ Offset FECT
(@ offset values up or down in selected columns. (?) Offset values up or down in selected columns.
[Z] (aFilter columns [l (aFilter columns
vl i vl
v ve v v2 | f
1 of 2 columns selected 1 of 2 columns selected i
Offset: 1 = Offset: 1 =
Direction: Down v Direction: Down v
wraparound V| wraparound .
New value: 0 New value: F
vl *\12 vl *2
1 1 0 1 1 5
2 2 1 2 2 1
3 3 2 3 3 2
4 4 3 4 4 3
5 5 4 5 5 @
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Inputs
One.

Options

e Check the column(s) you wish to transform.

o Set Offset to the number of rows you wish to offset values by.

¢ Set Direction to the direction you want to offset in.

e Check wraparound if you want values pushed off the bottom of the table to be added to
the top or values pushed off the top to be added to the bottom.

e Set New value to the value you wish to set for any cells newly created by the offset.

Notes
e You can use Copy Cols to create copies of columns before you offset them.

See also
o New Rows

2.3.33 Pad

Description
Pad text to a minimum length in one or more columns.

Example
Pad the 'ld' column to 10 digits using zeros:
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Id Name
1 1 Alice
2 2 Bob
3 3 Charlie
4 4 Dwayne

v

Pad iﬁ} E ;
@ Pad the selected column(s) to a fixed length.

El Q Filter columns

Id

v

MName

1 of 2 columns selected

Minimum length: 10 =

Pad: Left v

Pad with: Zeros v
Id Name

1 0000000001 Alice
2 0000000002 Bob
3 0000000003 Charlie

4 0000000004 Dwayne
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Minimum length to the length you want values in selected columns padded to.
Values this length or longer are unaffected.

¢ Set Pad to Left or Right depending on where you want any padding characters added.

¢ Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before padding.

2.3.34 Pivot

Description
Creates a pivot table to summarize values for one or two columns.

Example
Pivot to sum 'Amount’ by 'Area’ and 'Currency":
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Area Currency Amount

13937.00

22894.90

3 Africa ZAR 12745.55

48356.95

5 Europe GBP 1100.00
5905.80
Pivot x:f} = EQE
@ Create a pivot table to summarize the selected ... ;
Columns: Currency .
Rows: Area v
Values: Amount v
Summarize by: Sum v
Set non-calculated: Zero v
Vv add totals
Total by: Rows and columns v

Sum Amount

1 Africa 0 0 0 12745.55 12745.55

2 m 198428 1100 0 0 20942.8

3 North America 0 0 71251.85 0 71251.85

4 Total 19842.8 1100 71251.85 12745.55 104940.2
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Inputs
One.

Options
e Set Columns to the column values you want to use as columns in your pivot table.
¢ Set Rows to the column values you want to use as rows in your pivot table.
¢ Set Values to the column you wish to summarize.
e Set Summarize by to how you wish to summarize the values:
o Sum show the sum of the values. Non-numeric and empty values are ignored.
o Minimum shows the smallest value. Non-numeric and empty values are ignored.
o Maximum shows the largest value. Non-numeric and empty values are ignored.
o Average shows the arithmetic mean of the values. Non-numeric and empty values are
ignored.
o Median shows the median of numeric values in the column. Non-numeric and empty
values are ignored.
o Mode shows the mode of numeric values in the column. Non-numeric and empty
values are ignored.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s). Non-numeric and empty values are ignored.
o Count shows the number of values. Empty values are ignore (a value that contains
whitespace is not considered empty).
¢ Set Set non-calculated depending on how you want to set cells not calculated by the
pivot.
e Check add totals to add row and/or column totals.
¢ Set Total by depending on whether you want to total by Rows and columns, Rows or
Columns. This is only available if add totals is checked and Columns and Rows are
selected.

Notes

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.

See also
e Count
e Stats

e Summary
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2.3.35 Remove Cols

Description
Removes columns.

Example
Remove the 'Area' column:
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Area Currency Amount

1 Europe EUR 13937.00

2 North America USD 22894.90

3 Africa ZAR 12745.55

KAt

Remove Cols Q{: = vyt

@ Uncheck columns you wish to remove.

o —
E Q Filter columns

:
Area !
c |
urrenc !
v oo E
i
Amount
v i
g
Currency Amount
1 EUR 13937.00
2 UsSD 22894.90
3 ZAR 12745.55
Inputs
One.
Options

e Uncheck the column(s) you wish to remove.

Easy Data Transform © 2022 Oryx Digital Ltd



Reference

Notes
e The column will be removed from any dataset ‘downstream’.

See also
e New Col
2.3.36 Rename Cols

Description
Rename column headers.

Example
Rename columns 'first' to 'First' and 'Last' to 'last":

first last
1 John Smith
2 Jane Smith
Rename Cols CF 5 EQ
@ Rename column headers.
a || A ||Aa||58
Old name MNew name
first First
last Last
First Last
1John Smith
2 Jane Smith
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Inputs
One.

Options

e Change the column headers using the New name column.

e Click Lower to change all the names in the New name column to lower case.

e Click Upper to change all the names in the New name column to upper case.

e Click Title to change all the names in the New name column to title case.

¢ Click Replace to replace text in the New name column using text, exact text or Regular

expression matching.
e Click Reset to change all the names in the New name column back to their original name.

Notes
e The names of column headers do not have to be unique.
e Warnings are shown in the Info tab for duplicate column names (case sensitive).

2.3.37 Reorder Cols

Description
Reorder columns.

Example
Reorder 'Last’, 'First' and 'Title' columns:
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Last First Title
1 Smith John Mr

ZSmiIhMDr

Reorder Cols dj =2 Eg
@ Drag columns to reorder.

T 1™V LUENEC

Title

First
Last

Title |First | Last

1 Mr  John Smith
2 Dr Smith
Options

Drag the columns into the desired order (left-most at the top).

Click the Move first button to move the selected columns to be first.

Click the Move up button to move the selected columns up one place.

Click the Move down button to move the selected columns down one place.
Click the Move last button to move the selected columns to be last.

Click the Sort ascending button to sort the columns in ascending order.
Click the Sort descending button to sort the columns in descending order.
Click the Reset button to restore the original column order.

Inputs
One.
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Notes

e You can also rename columns with Rename Cols and remove unwanted columns with
Remove Cols.

e Number, date and text values are treated differently for sorting purposes.

2.3.38 Replace (deprecated)

This transform is deprecated. Use Replace instead.

Description
Replace text in one or more columns.

Examples
To turn 0123456789 into (+44) 1234 56789 using a Regular expression:

Match type: Regex v ‘
Replace:  O(\d\d\d\d)(\d\d\d\d\d) !
|
With: (+44)\1\2 |
Inputs
One.
Options

e Check the column(s) you wish to transform.

e Choose the Match type as:
o Text to replace matches contained in the text.
o Exact text to replace the text only if it matches exactly (whitespace sensitive).
o Regex to match using a Regular expression.
o Empty to match empty cells (cells with whitespace are not empty).

¢ In Replace put the text you want to replace for Text, Exact text or Regex matching. You
can use a column variable.

¢ In With put the text you want to replace it with. You can use a column variable.

e Check case sensitive to use case sensitive matching for Text, Exact text or Regex
matching.

Notes
e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before replacing.
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See also
e Insert
e Substitute

2.3.39 Replace

Description
Replace text in one or more columns.

Examples
Replace US state initials in the 'Address' column:
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First Last Address
1 Jane  Smith 100 W St, Tucson, AZ

2 Ahmed Ali 17 N St, Anchorage, AK

3 Josh  Jones 123 S St, Fort Smith, AR

‘

Replace OU te

[T

@ Replace multiple text in the selected column(s). ...
E Q Filter columns
Last =

v A_ddress

| 3
1 of 3 columns selected

@MV ®E & X

Match Type Replace With
1 Text v AK Alaska
2 Text ¥ AR Arkansas
3 Text ¥ AZ Arizona

v case sensitive

y

First Last Address

1Jane  Smith 100 W St, Tucson, Arizona
2 Ahmed Ali 17 N St, Anchorage, Alaska

3 Josh  Jones 123 S St, Fort Smith, Arkansas
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Reformat phone numbers using a regular expression:
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Home Business

I
! 10123456789 0123489404
I

2 0139384892 0129347236

3 0153498348 0150923404

B

R Al
Replace o d Ee
@ Replace multiple text in the selected column(s). Can use powerf...
[ =] (@ Filter columns

Home

v

Business

v

2 of 2 columns selected

@ ML ®E S X

Match Type Replace With
1/ Regex ¥ oQd\d\d\d)(\d\d\d\d\d) (+44) \1\2

V

Home Business

1/(+44) 1234 56789 (+44) 1234 89404

v case sensitive

2 (+44) 1393 84892 (+44) 1293 47236

3 (+44) 1534 98348 (+44) 1509 23404

Replace empty values:
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| nt nZ n3

1 123.8 9876.1

2981234 23.3
3 288
Replace OF Eg

@ Replace multiple text in the selected column(s). Can use powerf...

El Q Filter columns

nt

4

v "

JI"IE

3 of 3 columns selected |
® 1T L ®EE&E X |

Match Type Replace With
1 Empty v 0.0

- I
v case sensitive

y

ni n2 n3

11 123.8 9876.1 0.0

2981234 00 233

3 288 00 00
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Remove symbols:
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Amount
1 $100.0
2 $95.2
3 $45.3
4 $15.6
Replace * ﬁf B Eg

@ Replace multiple text in the selected column(s).
E E Q Filter columns

Amount

v

1 of 1 columns selected

@1V ®BE&E X

Match Type Replace With

1 Symbols v

Amount
1 100.0
2 95.2
3 45.3
4 15.6
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Inputs
One.

Options
e Check the column(s) you wish to transform.
e Click the ® button to add a new filter criteria.
e Click the T button to move the selected terms up.
e Click the "' button to move the selected terms down.
e Click the ® button to delete the selected filter terms.
e Click the B button to copy all terms to the clipboard.
e Click the & button to paste terms from the clipboard.
e Click the X button to clear all terms.
e Add the terms you wish to replace and how you wish to replace them.
o Choose the Match type as:
» Text to replace matches contained in the text.
= Exact text to replace the text only if it matches exactly (whitespace sensitive).
= Regex to match using a Regular expression.
* Empty to match empty cells (cells with whitespace are not empty). The Replace value
is ignored.
= Letters to match letters, e.g. 'a’. The Replace value is ignored.
» Digits to match numeric digits, e.g. '1". The Replace value is ignored.
* Punctuation to match punctuation characters e.g. ',". The Replace value is ignored.
» Symbols to match symbol characters e.g. '$'. The Replace value is ignored.
= Space to match white space characters. The Replace value is ignored.
o In Replace put the text you want to replace for Text, Exact text or Regex matching.
You can use a column variable.
o In With put the text you want to replace it with. You can use a column variable.
e Check case sensitive to use case sensitive matching for Text, Exact text or Regex
matching.

Notes

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before replacing.

e If you are pasting in replacement terms, the format expected is comma delimited text with
3 columns.
o The first column is the 0-based index of the Match Type drop-down list.
o The second column is the text Replace.
o The third column is the text With.

For example, pasting in:
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0,YES, 1
2,7v8,1
Will add:
Match Type Replace With
1 Text ¥ |YES 1
2 Regex v |AYS 1

You can also try copying terms to the clipboard and pasting into a text file to see the
format. If you only paste in 1 column of text, it will be assumed to be a list of Replace. You
can, of course, use Easy Data Transform to create the appropriate filter terms and paste
them into memory.

See also
e Insert
e Substitute

2.3.40 Row Num

Description
Add a new column that contains the row number.

Example
Add a row number starting at 1:
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Product Id
1 AD0001

2 A00002

3 A00003

Row Num &@Eg

® Add a new column with the row number.

Start at: 1 -
Increment: 1 -
Every: 1 ‘ -
Product Id Row Num
1 A000O01 1
2 AD0002 2
3 A00003 3
Inputs
One.
Options

e Set Start at to the number you want to use for the first row.

¢ Set Increment to the amount you wish to increment by.

¢ set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).
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Notes

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

e You can Pad the row number with zeros to turn it into a column of unique Ids with a fixed
length.

2.3.41 Sample

Description
Selects a subset of rows from the input.

Example
Sample 3 rows from 5:
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Timestamp Temperature ( F) Humidity (RH )
1 2020-10-19T20:40 143.5 108
22020-10-23T19:45 119.6 127

5 2020-11-05T07:15 130.8 132

Sample - Vo d E C'
® Sample from all rows. Useful for testing changes to d...
Rows: 3 -
Select: Evenly v
Random seed: 93267 =

disable sampling

'

‘Timestamp Temperature (F) Humidity (RH )
1.2020-10-23T19:45 119.6 127

2020-10-30T16:40

Inputs
One.
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Options

¢ Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

e Check disable sampling to turn off sampling. If sampling is disabled, the transform does
nothing.

Notes

e If you set Select to Randomly (for quality) or Randomly (for speed), rows will be
selected using a pseudo-random number generator, initialized with Random seed.
Changing the seed will change the rows sampled.

¢ With the same Random seed and the same Select value you should get the same
random sampling, even across Windows and Mac versions of Easy Data Transform.

¢ Random (for speed) is significantly faster than Randomly (for quality), but the results
may be less random.

e If you are transforming a large dataset, then you can use Sample to test a small subset.

e If you need to do something more complex than Sample can handle (e.g. keep only rows
500 to 1000) then use Slice or Row Num followed by a Filter. For the most complex cases
use Row Num, followed by JavaScript, followed by a Filter. E.g. this JavaScript function
returns 1 for every 10th row between 1000 and 2000 and 0 otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $(Row Num) % 10 == 0;
2.3.42 Scale

Description
Scale numeric values, e.g. to a percentage or 0 to 1.

Examples
Scale a single column to a percentage:
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Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale tf’ E i

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item

J Di-s.pgted

1 of 2 columns selected

4)p

Scale to : 100
Using:  Sum v

Of: All values v

v

ltem Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions 20.5633113897

3 Unknown 13.6227590823




Reference

Scale a table with row, column and grand totals to a percentage (scale to 400 as each value
is also added to the row total, column total and grand total):

Easy Data Transform © 2022 Oryx Digital Ltd



Reference

Sum Amount EUR GBP usD ZAR Total
1 Africa 0.00 0.00 0.00 12745.55 12745.55

2 Europe 19842.80 1100.00 0.00 0.00 20942.80
3 North America 0.00  0.00 71251.85 0.00 71251.85

4 Total 19842.80 1100.00 71251.85 12745.55 104940.20

Y

A
Scale o 3]== vEe
® Scale numeric values, e.g. to a percentage or 0 t... |

o -
IEI Q Filter columns

Total
Vv _

5 of 6 columns selected

1)

Scale to : 400

Using:  Sum

Of: All values v

v

Sum Amount EUR GBP usD ZAR Total
1/ Africa 0 0 0 12.1455362197 12.1455362197

2 Europe 18.9086737018 1.0482160316 0 0 19.9568897334

3 North America 0 0 67.8975740469 0 67.8975740469

4 Total 18.9086737018 1.0482160316 67.8975740469 12.1455362197 100
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Scale heights and weights so that the largest in each column is 1.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
Scale Oa 3 Q I

@ Scale numeric values, e.g. to a percentage or 0 t...

o .
E Q Filter columns

Name

v Hv.elght.{m} | |

v w?.ight (Kg) |

2 of 3 columns selected

Scale to : 1 :
|

Using:  Maximum v |
|

Of: Each column Y

V

Name Height (m) Weight (Kg)
1 Alice 0.8168316832 0.6632653061

2 Bob  0.9851485149 1

3 Charlie 0.9554455446 0.7755102041

Easy Data Transform




Reference

Inputs
One.

Options

¢ Set Columns to the columns whose values you want to scale.

¢ Set Scale to the value you want to scale to. E.g. 100 for a percentage.

¢ Set Using depending on whether you want to use the Sum or Maximum of values for
scaling.

o Set Of depending on whether you want to scale for Each column, Each row or for All
values.

Notes
e Whether values are interpreted as numbers depends on Locale in the Preferences
window.
¢ Non-numeric values (including empty values) are ignored.
e The results for negative values are undefined.
e To replace empty values with zeros use the Replace transform.
e To modify the numerical precision of the results use the Num Format transform.
e To add a '%' at the end of values use the Insert transform.
e To copy columns before using Scale use Copy Cols .
e Warnings are shown in the Warnings tab for non-numeric values.
2.3.43 Slice

Description
Keep or remove a continuous section of rows.

Example
Keep only the records between the 'YEAR' rows:
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1 2 3 4
1 YEAR JAN FEB MAR

2 1980 256.9 238.5 2754
3 1981 2489 2249 259.1
4 YEAR JAN FEB MAR
5 1982 258.6 230.0 2804

6 1983 2759 2349 2519

¢

Slice I:P = Eg
® Keep or remove a continuous section of rows.
Mode: Keep v
From: First row where v
Column: 1 v
Matches: = Equal to v
Value:  YEAR

include 'From' row

To: Last row where v
Column: 1 v
Matches: = Equal to v
Value:  YEAR

include 'To' row

v case sensitive

'

1 2 3 4




Reference

Inputs
One.

Options

¢ Set Mode depending on whether you want to keep or remove the slice.

¢ Set From according to how you want to choose the first row of the slice.

¢ Set Column, Matches and Value to match the first row. You can use a column variable for
either Value.

e Uncheck Include 'From’ row if you don't want to include the first row in the slice.

¢ Set To according to how you want to choose the last row of the slice.

e Set Column, Matches and Value to match the last row.

e Uncheck Include 'To’ row if you don't want to include the last row in the slice.

e Check case sensitive to use case sensitive matching for text.

Notes

e Number, date and text values are treated differently for Equal to, Greater than, Less
than, Greater than equal, Less than equal and Not equal to operations. Any values that
can be converted to a number will be treated as a number. Any values that match the
supported date formats in Preferences will be treated as a date.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn’t end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

e If you want to keep or remove a selection of rows by row number, use a Row Num
transform followed by a Filter transform.

2.3.44 Sort

Description
Sorts rows by one or more columns.

Example
Sort by 'First' and then 'Last 'columns:
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Title First Last

1Mr John Smith

2 Dr |Jane ‘Smith

3 Mr ‘Albert‘Smith

4 Mr  John Doe

v

Sort (f} D ;

@ Sort rows by text, numeric and date values in th... |

CNR A

Column Order
1/ Last ¥ Ascending v
2| First ¥ Ascending v

v

Title _First _Last

1/Mr  John Doe

3Dr Jane Smith

4 Mr John Smith

Inputs
One.

Options

e Click the ® button to add a new sort level.
e Click the T button to move the selected sort levels up.
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e Click the \ button to move the selected sort levels down.

o Click the ® button to delete the selected sort level(s).

e Click the X button to clear all sort levels.

¢ Set Column to the column you want to sort by.

¢ Set Order depending on whether you want to sort this column Ascending or
Descending.

Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for sorting purposes.

e Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Whitespace to remove whitespace before sorting.

2.3.45 Split Col

Description
Split text at delimiters in a selected column to create multiple columns or rows.

Example
Split the 'Courses' column into multiple columns or rows:
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Name Courses

1 Alice C001,H005
2 Bob  P0O0O2
3 Charlie|C001,P003

4 Denzil |E007,C001,H005

Split Col B L3 | split col Sl =i
® Split a column into multiple new columns. @ Split a column into multiple new columns. |
Column: Courses v Column: Courses - |
Delimiter: Delimiter:

Into: Columns v Into: Rows ~
Ordering:  Current v Ordering:  Current v
keep empty keep empty
Min. values: 0 21 |Min. values: 0 -
Max. values: 100 ‘ + | |Max. values: 100 - I
Name Courses Courses1 Courses2 Courses3 e e M

1 Alice  C001,H005 €001 H005 1 Alice €001

e R R 2 Alice  HO05

3 Charlie C001,P003 Coo1 ‘POOB 3Bob  POO2

4 Denzil EOO?,COOLHOOS\E&Oi __JEO._!____ Hoos . Charliem

5 Charlie POD3
6 Denzil EO07
7 Denzil €001
8 Denzil HOO5

Inputs

One.

Options

e Select the Column you wish to split.
e Supply the Delimiter for splitting the column (e.g. comma).
e Set Into to:
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o Columns to create a new column for each split value.
o Rows to create a new row for each split value (the original row is removed).

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to keep empty values (e.g. honor delimiters with nothing
in between).

¢ set Min. values to the minimum number of columns/rows you wish to split each value
into.

¢ set Max. values to the maximum number of columns/rows you wish to split each value
into (ignored if less than minimum).

Notes

e If no Delimiter is supplied then no new columns are created.

e If Into is Columns, new columns are added at the right end. You can change the column
order with Reorder Cols.

e If there is a header, the header of the new column is based on the original header. You
can change the column name with Rename Cols.

e The opposite of Split Col with Into as Columns is Concat Cols.

¢ The opposite of Split Col with Into as Rows is Unique.

See also
e Split Rows

2.3.46 Split Rows

Description
Split each row into multiple rows.

Example
Split rows before each column containing 'title":
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Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 er ‘John Smith Dr Jane Smith
2‘Mr Bill Brown Mrs Andrea Brown
Split Rows (f' fe] E:

® Split each row into multiple rows.
Split each row:

® before each column where name ¢ ™ title
. Y
1 time before <None ¥ then every|1 columi

automatically using repeated column names

'

Guest title Guest first name Guest last

Vv case sensitive

1| Mr John Smith

3 Mr Bill Brown

4 Mrs Andrea Brown

Inputs
One.

Options
¢ Split by column name:
o Each row will be split before each column that matches the criteria.
e Split a fixed number of times:
o Define the number of times you want to split each row, starting before which column
and then every N columns.
o The split is added before the designated columns.
o Splits after the last column are ignored. So you can set times to a large number if you
don't know how many columns there will be.
¢ Split automatically:
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o Find the first column name that appears more than once and split each row before each
column with that name.
e Check case sensitive to use case sensitive matching for column names.

Notes

e Comparisons of column names are whitespace sensitive.

e Use the keyboard up and pown arrow keys to move the focus between the ‘radio’ buttons.

e Splits added before the first column are ignored, as there is already a split there.

e Use New Col or Rename Cols if you need to add additional columns or rename columns
before splitting rows.

e The opposite of Split Rows is Concat Rows.

See also
e Gather

e Split Col
2.3.47 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or crosstab.

Example
Spread 'Quarter' and 'Amount’ columns to multiple columns:
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salesman area Quarter Value

1 Alice North Q1 1.3
2 Alice North 89.3
3 Alice MNorth Q23 44 3
4 Alice North -E
5 Bob East Q1 4.5
6 Bob East 79
7 Bob East Q3 8
8 Bob East 3.3
Spread tf’ EC
@ Spread the selected key and value columns into m...
Key column:  Quarter v
Value column: Value v

Missing value:
Min. new cols: 0

Max. new cols: 100

4)

2 Bob East 45 79 8 33
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2.3.48

Inputs
One.

Options

¢ Select the Key column and Value column you wish to spread.

¢ Missing values is used for values missing from the input dataset.

e set Min. new cols to the minimum number of new columns you wish to add.

¢ set Max. new cols to the maximum number of new columns you wish to add (ignored if
less than minimum).

Notes

o If there are rows that are duplicates, apart from the value column, this will cause errors.

e New columns are added at the right end. You can change the column order with Reorder
Cols.

¢ You can merge the new columns into a single column with Concat Cols.

e The opposite of Spread is Gather.

Stack

Description
Merge rows from inputs, one on top of the other.

Examples
Stack 3 employee datasets by header name:

|
Stack & B

Name ID DOB i
@ Merge input datasets one on top of another. Or...

employeesl.c...
1/John Black 001 1955'07'01*0 Align columns by: Header name v

3 cols x 2 rows
2|Paul White 002 1973-03-11 /
D DOB

Name Name ID DOB
il employees2.c... Stack
1003 Jill Green 1977-12-30 *0 —® A*‘I John Black 001 1966-07-01
" 3 cols x 2 rows 3 cols x 6 rows
2| 004 Ahmed Ali 1980-11-05 2 Paul White 002 1973-03-11
== T 3Jill Green 003 1977-12-30
11968-12-12 005 Lars Hansen *gemp'c’ye‘%lc‘" 2 Ahmed Al 004 1980-11-05
. . 3 col 2 ]
21977-01-05 006 Pierre Martin wiErarons 5|Lars Hansen 005 1968-12-12
6 Pierre Martin 006 1977-01-05

Stack 2 employee datasets by column number:
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Stack CP EC
Name ID DOB @ Merge input datasets one on top of another. Or...
1 John Black 001 1966-07-01 *Oemployeesl.c_._ Align columns by: Column number v
2 Paul White 002 1973-03-11 Jeolsdons e e e

1/John Black 001 1966-07-01
o Stack gl 2 Paul White 002 1973-03-11
3 cols x 4 rows

3 Jill Green 003 1977-12-30

4 Ahmed Ali 004 1980-11-05

full name id date of birth
1 JillGreen 003 1977-12-30 *gemployeesz'c'"

3 cols x 2 rows

2 Ahmed Ali 004 1980-11-05

Inputs

One or more.

Options

e Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id" column in input 2) and Column number
to align by the column number (e.g. the first column of input 1 with the first column of
input 2). The headers will be matched in order:
o case and whitespace sensitive (e.g. 'ID' to 'ID"); then
o case insensitive and whitespace sensitive (e.g. 'lId' to 'ID"); then
o case sensitive and whitespace insensitive (e.g. 'ID' to ' ID ); then
o case and whitespace insensitive (e.g. 'ld" to ' ID )

e The stacking order depends on the vertical (Y-axis) position of the inputs.

Notes
e Stack merges datasets one on top of the other (vertically). To merge datasets side-by-side
(horizontally) use Join.
e If you align by Column number the header of the first input is used.
e Messages are shown in the Warnings tab for:
o duplicated column names within an input dataset when Align columns by is set to
Header name
o columns stacked under columns with different names when Align columns by is set to
Column number
o differing numbers of columns between input datasets
e It is sometimes useful to Stack a single dataset, so you can add more inputs later.

See also
e Cross

Easy Data Transform © 2022 Oryx Digital Ltd



Reference

e Join
¢ Merge datasets
2349 Stamp

Description
Adds a stamp with time, date and other information as a new row or a new column.

Example
Add the current date to the end of each row:

Generation [kW] Grid [kW]  Solar [kW]
1 1.904804444 0.372133333 1.904804444

2 2.072017778 0.470303333 2.072017778

3 1.980881111 0.426542222 1.980881111

4

Stamp d} === Ezlu

@ Add a processing date/time stamp. r
Format: -- dd/MM/yyyy --

Position: Every row v

v

Generation [kW] Grid [kW]  Solar [kW] Stamp
1 1.904804444 0.372133333 1.904804444 -- 07/06/2021 --

2 2.072017778 0.470303333 2.072017778 -- 07/06/2021 --

3 1.980881111 0.426542222 1.980881111 -- 07/06/2021 --

Inputs
One.
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Options

e Supply the stamp format in Format (see below).

Format Meaning

d The day as number without a leading

zero (1 to 31)

el The day as number with a leading zero
(01 to 31)

ddd The abbreviated localized day name
(e.g. 'Mon' to 'Sun’). Uses the system
locale to localize the name.

delesl The long localized day name (e.g.
‘Monday' to 'Sunday'). Uses the system
locale to localize the name.

M The month as number without a leading
zero (1 to 12).

MM The month as number with a leading
zero (01 to 12)

MMM The abbreviated localized month name
(e.g. Jan' to 'Dec’). Uses the system
locale to localize the name.

MMM The long localized month name (e.g.
‘January' to 'December’). Uses the
system locale to localize the name.

Yy The year as two digit number (00 to 99).

yyyy The year as four digit number. If the
year is negative, a minus sign is
prepended in addition.

h The hour without a leading zero (0 to
23 or 1 to 12 if AM/PM display).

hh

The hour with a leading zero (00 to 23
or 01 to 12 if AM/PM display).
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Format Meaning

H The hour without a leading zero (0 to

23, even with AM/PM display).

HH The hour with a leading zero (00 to 23,
even with AM/PM display).

m The minute without a leading zero (0 to
59).

mm The minute with a leading zero (00 to
59).

s The whole second without a leading
zero (0 to 59).

S The whole second with a leading zero
where applicable (00 to 59).

z The fractional part of the second, to go
after a decimal point, without trailing
zeroes (0 to 999). Thus "s.z" reports the
seconds to full available (millisecond)
precision without trailing zeroes.

AP or A The fractional part of the second, to
millisecond precision, including trailing.

ap or a Use am/pm display. a/ap will be
replaced by either "am" or "pm".

t The timezone (for example "CEST").

% (c) The computer name.

() The path of the .transform file, e.g. C:
\Users\andy\Desktop\mytransform.tran
sform

S (u) The name of the user (from the USER or

USERNAME environment variable).

¢ Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.
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Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.
e The Format text is case-sensitive.

See also
e Meta information
e Stack

2.3.50 Stats

Description
Calculates statistics by column and/or row in one or more selected columns.

Example
Calculate column and row averages:
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Grid [kW]  Solar [kW]
1 0.372133333 1.904804444

2 0.470303333 2.072017778

3 0.426542222 1.980881111

‘

KA
Stats o 4l ZZE R
@ Calculate sum, min, max, average, median or st...
IE' Q Filter columns

v Grid [kW]

y Solarfwl i

2 of 2 columns selected

Calculation: Average bt

On: Columns and rows v

Grid [kW] Solar [kW] Average
1 0.372133333 1.904804444 1.1384688885

2 0470303333 2.072017778 1.2711605555
3 0426542222 1.980881111 1.2037116665

4 0.4229929627 1.985901111 1.2044470368

Inputs
One.
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Options
e Check the column(s) you wish to calculate stats for.
¢ Set Calculation to the statistic you want to calculate:
o Sum show the sum of the values.
o Minimum shows the smallest value.
o Maximum shows the largest value.
o Average shows the arithmetic mean of the values.
o Median shows the median of numeric values in the column.
o Mode shows the mode of numeric values in the column.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).
o Variance is the square of the sample standard deviation.
o Q1 is the first quartile (calculated using Method 1 here).
o Q3 is the third quartile (calculated using Method 1 here).
o IQR is the Inter Quartile Range.
o Skew is the alternative Pearson Mode Skewness (3 * (Mean — Median) / Standard
Deviation ).
¢ Set On depending on whether you wish to calculate the statistics for columns, rows or
both.
o If On is set to Columns an extra row with the results is added to the bottom.
o If On is set to Rows an extra column with the results is added to the right.
o If On is set to Columns and rows an extra row with the results is added to the bottom
and extra column with the results is added to the right. The bottom right cell
contains the calculation across all values.

Notes

e Non-numerical and empty values are ignored.

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.

See also

e Count

e Pivot

e Summary
2.3.51 Substitute

Description
Substitute column values into text.
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Example
Create an SQL statement to insert 'date’, 'cases’, 'deaths' and 'country’ values into 'mytable":

date cases deaths country

12020-05-03 134 4 Afghanistan
2 2020-05-03 7 0 Albania

32020-05-03 141 6 Algeria

v

Substitute (f B Dg

® Substitute column values into text.

New column name: SQL ;

Substitution script:

INSERT INTO mytable (country,date,deaths,cases) VALUES ($(country),$(date),$(deaths),$(cases));

+

date cases deaths country sqQL |

12020-05-03 134 4 Afghanistan INSERT INTO mytable (country,date,deaths,cases) VALUES (Afghanistan,2020-05-03,4,134);

2 2020-05-03 7 0 Albania INSERT INTO mytable (country,date deaths,cases) VALUES (Albania,2020-05-03,0,7); |
3 2020-05-03 141 6 Algeria INSERT INTO mytable (country,date,deaths,cases) VALUES (Algeria, 2020-05-03,6,141); !
Inputs
One.
Options

e Enter your substitution script into the Substitution script field.

e Select a column from Insert variable to add that column variable into the Substitution
script field at the current cursor position.

e Click the Evaluate button to evaluate your script over every row.

Notes
e The transform is calculated every time:
o The Evaluate button is pressed.
o The Substitute transform item is unselected in the Center pane and script changes
have been made without the Evaluate button being clicked.
o The item upstream of it changes.
e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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e If you want to carry out your transform across more than one dataset, you should Join

them first.
e If you need to do something more complex than this transform allows, try the JavaScript
transform.

¢ Warnings are shown in the Warnings tab for ambiguous column references.
2.3.52 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Example
Subtract from the top dataset all the records with ids in the bottom dataset:

Subtract Cf} = EC
@ Remove rows from the top dataset whose key values are ...
Top key column: Id v
Id First Bottom key column: ID N

1 001 Alice

* btract-a.csv
2 002 Bob ) su
3 003 Charlie 2 cols x 4 rows

4 004 Dwayne d First

/] Subtract V*1 002 Bob

2 cols x 2 rows

2 004 Dwayne

subtract-b.csv
1 001 * 6
ZM 1 colx 2 rows

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

¢ Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input
dataset.
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e Check case sensitive to use case sensitive matching for keys.

Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess
sensible default values for Top key column and Bottom key column based on column
header names and contents.

e If the first input has a header, this will be used for the output.

¢ All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the subtract.

¢ All rows in the top dataset with a given key value are removed if that key value occurs 1 or
more times in the bottom dataset.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name’
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Intersect
2.3.53 Summary

Description
Summarize the values in the selected columns.

Example
Create a summary, including dates and statistics:
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date cases deaths country

1 2020-05-03 134 4 Afghanistan

2 2020-05-03 7 0 Albania

3 2020-05-03 141 6 Algeria

y

KA

Summaw (f} @ Y |

@ Summarise the values of the selected columns.
E IE' Q Filter columns

v, date -

cases

v

v dgaths

4 of 4 columns selected
v include dates

v include statistics

Metric date cases deaths country

i 1 |Empty values 0 0 0 0
i 2 Non-empty values 3 3 3 3
3 Numeric values 0 3 3 0
4 Integer values 0 3 3 0
5 Date values 3 0 0 0
6 Text values 0 0 0 3

l 7 Distinct values 1 3 3 3
8 Unique values 0 3 3 3
9 Duplicated values 1 0 0 0

Easy Data Transfo
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Inputs
One.

Options

¢ Select the Columns you wish to summarize.

¢ Check include dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.

¢ Check include statistics if you wish to add the sum, average, median and standard
deviation for numeric values.

Notes

e Whether values are interpreted as number or dates depends on Supported date formats
and Locale in the Preferences window.

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Non-empty values is the number of values in the column that are not completely empty.
Values with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

¢ Integer values is number of numeric of values in the column that can be interpreted as
integers (whole numbers). "1.0" (depending on your Locale), "0", "-1" and "1e3" are
considered integers.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

¢ Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

e Distinct values is the number of different values in the column. Date and numeric values
are treated as text (e.g. '7" is treated as different to '7.0' and '1/1/2020" is treated as
different to '01/01/2020'). Comparison between values is sensitive to case and whitespace.
Empty values are not counted.

¢ Unique values is the number of values that only occur once in the column. Date and
numeric values are treated as text. Comparison between values is sensitive to case and
whitespace. Empty values are not counted.

¢ Duplicated values is the number of values that only more than once in the column. Date
and numeric values are treated as text. Comparison between values is sensitive to case
and whitespace. Empty values are not counted.

¢ Min length is the minimum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Max length is the maximum number of characters of a value in the column. Whitespace is
counted. Date and numeric values are treated as text.
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¢ Min numeric is the minimum numeric value in the column. Non-numeric and empty
values are ignored.

e Max numeric is the maximum numeric value in the column. Non-numeric and empty
values are ignored.

¢ Range numeric is Max numeric - Min numeric.

e Sum numeric is the sum of numeric values in the column. Non-numeric and empty values
are ignored. Only shown if include statistics is checked.

e Average numeric is the arithmetic mean of numeric values in the column. Non-numeric
and empty values are ignored. Only shown if include statistics is checked.

¢ Median numeric is the median of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

¢ Mode numeric is the mode of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

¢ Stddev numeric is the sample standard deviation (equivalent to Excel function stddev.s)
of numeric values in the column. Non-numeric and empty values are ignored. Only shown
if include statistics is checked.

¢ Variance numeric is the square of the sample standard deviation. Only shown if include
statistics is checked.

¢ Q1 numeric is the first quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ Q3 numeric is the third quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ IQR numeric is the Inter Quartile Range. Only shown if include statistics is checked.

¢ Skew numeric is the alternative Pearson Mode Skewness (3 * (Mean — Median) /
Standard Deviation ). Only shown if include statistics is checked.

¢ Min date is the minimum date value in the column. Only shown if include dates is
checked.

¢ Max date is the maximum date value in the column. Only shown if include dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to
case and whitespace.

Notes

e Mode may not work as expected with non-integer values, due to precision issues. You
can fix this by using a Num Format transform first.

e Use Num Format to change the precision of numerical results.

e You can use Whitespace to remove any whitespace at the start or end of values before
Summary.

e If you wish to have a row displayed per column you can Transpose the table first.
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Description
Add a new column with a running (cumulative) total of the selected column.

Examples
Total the 'transaction' column:
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area transaction
1 North 100
2 South 200
3 North -50
4 South 320
5 East 200
6 East -50
Total ‘-f.'? = Eg
@ Add a new column with a running (cumulative) t...
Column: transaction v
By: <None selected> v

v

area transaction Total transaction
1 North 100 100
2 South 200 300
3 North -50 250
4 South 320 570
5 East 200 770
6 East -50 720

Total the 'transaction' column separately for each ‘area’ value:
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area transaction

1 North 100
2
3 North =50
Total =S
@ Add a new column with a running (cumulative) t...
Column: transaction v
By: area .

\

area transaction ITotaI transaction |
1 North 100 100
50 50

2

3 North

4
5
6

© 2022 Oryx Digital Ltd
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Inputs
One.

Options

e Set Column to the column you want to total.

¢ Set By to a column if you want a separate running total per value in that column. Leave as
<None selected> if you only want a single running total.

Notes

e Non-numerical values are ignored.

e The By column takes account of case and whitespace in values.

e The new column is added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.

See also
e Count

2.3.55 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.

Example
Swap rows and columns:
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Grid [kW] Solar [kW]
103721333233 1.904804444

2 0.470303333 2.072017778

3 0.426542222 1.980881111

Y

Transpose FECL
@ Swap rows and columns.
has header
1 2 3 4

1 Grid [kW] 0.372133333 0.470303333 0.426542222

2 Solar [kW] 1.904804444 2.072017778 1.980881111

Inputs
One.

Options

e Check has header to make the new first row into a header (requires >1 row).

Notes

e If the input dataset has a header, it will become the new first column. Use Remove Cols to
remove it.

e Datasets with very large numbers of columns can be slow to display.
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2.3.56 Unfill

Description
Set adjacent cells with identical values to empty in selected columns.

Example
Unfill down:
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Country Area  City

1 Country 1
2 Country 1 City 2

3 Country1 |Areal City3

4 Country 1 Area2 City1

5Country 1 Area2 City2

y

Unfill o] =2
@ Set adjacent cells with identical values to empty...
E] Q Filter columns

v Cc.-untr},».f

Area

4

J City

3 of 3 columns selected

Direction; Down v

v

Country  Area  City

1 Country 1 Areal City1

2 City 2
3 City 3
4 Area2 City 1
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Inputs
One.

Options
e Check the column(s) you wish to unfill.
¢ Select Direction depending on the direction you wish to unfill to.

See also
e Fill
2.3.57 Unique

Description
Remove duplicate rows based on keeping only unique values in selected columns

Example

If you have a dataset of orders and you want to:

e keep one row per unique Customer Id

e keep the first listed Name for each Customer Id

e concatenate Product Ids for each Customer Id, delimited by a comma

sum the Costs for each Customer Id

keep the latest Date for each Customer Id

add a Count column showing how many rows in the input correspond to each row in the
output
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Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown 89456 10.55 01/10/2020

3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown 98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020]

y

Unique )Cf} E :

@ Remove duplicate rows, keeping only rows with unique values in se...

Column Option
Name Keep first b4
Customer Id Keep unique v
Product Id Concat A
Cost Sum hs
Date Maximum o
Set All ¥ to Keep unique v

‘Keep unique’ for 1 of 5 columns

Concat delimiter: ,

v/ add count column

V

Name Customer Id Productld Cost Date Count
1 Alice Anderson C018930 13574 29.95 01/10/2020 1
2 Bob Brown 89456,98526 20.55 02/10/2020 2

3 Charlie Jones CO17783 96352,38746 44.95 03/10/2020 2
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Inputs
One.

Options

¢ Set an Option for each column:
o Only 1 row is kept where all the Keep unique columns have the same value.
o Keep first keeps first value in the current sort order.
o Keep last keeps the last value in the current sort order.
o Sum sums any numerical values. Blank values are ignored.
o Maximum keeps the maximum numerical or date value.
o Minimum keeps the minimum numerical or date value.
o Average takes the average (mean) of any numerical values. Blank values are ignored.
o Concat to concatenate values. Duplicate values are kept. All values are treated as text.
o Concat unique to concatenate values. Duplicate values are ignored. All values are

treated as text.

e Use the Set button to quickly set the option value for multiple columns.

¢ Set Concat delimiter if you want to add a delimiter between Concat or Concat unique
values

e Check add count column to add a column showing how many rows in the input dataset
created each unique row.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns set
to Keep unique. Comparisons are case and whitespace sensitive. You can use Case and
Whitespace to change case and whitespace before deduping.

e If no columns are set to Keep unique the transform won't do anything.

e If you are using Keep first or Keep last the sort order is important. You can use Sort to
change the sort order before deduping.

e The Dedupe transform is a less powerful (but simpler and faster) alternative to Unique.

e You can use Split Col Into rows to perform the opposite function to Unique.

e The opposite Unique is Split Col with Into as Rows

See also
e Dedupe a dataset
2.3.58 Units

Description
Change units of time, length, temperature etc.
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Example
Convert the 'Temperature' column from Celsius to Fahrenheit:
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Temperature
1 -20
2 0
3 20
4 40
5 60
6 80
7 100

y

Units

v

From:

To:

@ Change units of time, length, temperature etc.
E |E| Q Filter columns

Temperature

1 of 1 columns selected

Dimension: Temperature

Celsius/Centigrade

Fahrenheit
Temperature
1 -4
2 32

Easy Data Transform
i T |

o) R A
L8 ¢ N
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Dimension to the dimensions of the units you wish to convert.
¢ Set From to the units you wish to convert from.

¢ Set To to the units you wish to convert to.

Notes

¢ The Locale set in the Preferences window is used to decide how the number is
represented (e.g. decimal separators).

Unit disambiguation:

o Years are 365.25 days.

o Calories are thermal/small/gram (not nutritional) Calories.

o Miles are International/Statute Miles.

o Nautical miles are International Nautical Miles.

o Gallons (US) are liquid gallons.

o Pints (US) are liquid pints.

Warnings are shown in the Warnings tab for non-numeric values.

e Non-numerical and empty values are not changed.

Use Copy Cols to copy columns before you transform them.

Use Num Format to change the number format of the results.

Use Extract or Split Col to remove any unit symbols from the value before conversion, e.g.
to change "0.0 Kg" to "0.0".

e If you want to convert units not covered here you can do it using the JavaScript transform.

2.3.59 Whitespace

Description
Tidy whitespace (spaces, tabs, carriage returns etc) in the selected column(s).

Example
Tidy tabs, carriage returns and repeated spaces:
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ClB)<« -

Name

1 -Mr---John<Smith
2 Dr-Jane—Smith

3 Mr-Albert<-Smith--

Whitespace r_jf} E C

® Tidy whitespace (spaces, tabs, carriage returns e...

El Q Filter columns

MName

v

L | ]
1 of 1 columns selected

v trim leading and trailing whitespace
replace line feeds with spaces

replace tabs with spaces

replace non-standard spaces with spaces
remove carriage returns

convert consecutive spaces to one space

4SS S S S

remove non-printable characters

\

BEYZ R

Name

1 Mr-John-Smith

2 Dr-Jane-Smith
2 R A A O e i




Reference

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check trim leading and trailing whitespace to remove whitespace characters, such as
space and tab.

e Check replace line feeds with spaces to replace LF (\n) characters with spaces.

¢ Check replace tabs with spaces to replace tab (\t) characters with spaces.

e Check replace non-standard spaces with spaces to replace non-standard spaces (such
as non-breaking space, thin space etc) with spaces.

e Check remove carriage returns to remove CR (\r) characters.

e Check convert consecutive spaces to one space to replace 2 or more consecutive spaces
with a single space.

¢ Check remove non-printable characters to remove characters of Unicode type Other_*.
This include ASCII codes 0 to 31, such as tab, line feed, carriage return, bell and
backspace. It does not remove spaces.

Notes

e The operations are carried out in top to bottom order, e.g. Replace line feeds with
spaces is carried out before Convert consecutive spaces to one space.

e Click the eye icon in the Right pane to show whitespace in the data.

Data =~ Warnings @ Info  Comment 4

2 cols x 3 @) Read
>) B TV <=2 2T Bk
2 Press to show whitespace in the dataset as symbols:
1 =1 [Space:
5| o Tab: -
Carriage return: -
3 .3. [|Line feed: o

Non-breaking space: r
Other whitespace: o
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See also
e Case

2.4 Output
24.1  Output data

Once you have finished transforming your data you can output it in the following formats:
o CSV

e Excel

* JSON

e HTML

e Markdown

e Plain text

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the Save
as type drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.
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output.csv d:' Ei

@ Output to file.

Output to:  Single file v

File: C\Users\andy\Desktop\output.csv

Type: Delimited text >

Delimiter: Comma (,) v

Quoting: As needed v

Line endings: Automatic v

Encoding:  UTF-8 v
v Byte Order Mark

Write mode: Overwrite s
v write header

Alias: output

Set Output to depending on whether you want to output the dataset to a single file or
multiple files.

Set File to the location of the file you want to output (only available when Output to set to
Single file).

Set Files column to the column containing the location of the files you want to output to

(only available when Output to set to Multiple files).

¢ This column is not output.

e The location can be an absolute location (e.g. c:\users\andy\output.csv) or a location
relative to the .transform file location (e.g. results\output.csv).

e Folders output to must already exist.

e Empty or invalid locations (e.g. file names with illegal characters) are ignored.

e Check Confirm files if you want to manually confirm before writing to output files
(ignored for command line processing).

If you are writing to an Excel file the output will be written to a sheet called 'Easy Data
Transform' by default. You can change this by adding the sheet name inside [], e.g.
myfile.xlsx[mysheet].
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Set Type to the file type. The default type will be set according to the file extension and the
settings in the Output Extensions tab of the Preferences window.

Set Value types depending on how you want to set JSON types (only available for JSON
files).
¢ Automatic to let Easy Data Transform decide the JSON type depending on the contents
of each column.
e String to set the JSON type for all columns to String
e Manual to choose the JSON type of each column as:
o Automatic (based on column contents).
o Boolean.
o Number.
o String.
If you output a column as Boolean or Number any values not of that type will be output as
null.

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).

Set Quoting depending how you want to use quoting in the output (only available for

delimited text files, such as CSV and TSV).

¢ As needed to add quotes (") around values that contain the delimiter character, quote
characters or carriage returns.

e Always to add " quotes around every value.

¢ Never to never add " quotes around values (delimiters and carriage returns with values
are replaced with spaces).

Set Line endings to the control characters you wish to use to denote line endings (only

available for text files).

¢ Automatic to choose the standard line ending for the current operating system.

¢ Windows (CRLF) to choose the standard Windows line ending, carriage return+line feed
(\r\n).

¢ Mac\Unix (LF) to choose the standard macOS/Unix line ending, line feed (\n).

¢ Old Mac (CR) to choose the standard classic (pre mac OS X) Mac line ending, carriage
return (\n).

Set Encoding to the text encoding you wish to use (only available for text files).

Set Formatting depending on how you want to set the Excel cell formatting (only available
for Excel files).
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¢ Automatic to let Easy Data Transform decide cell formatting depending on the contents
of each column.
e General to set the cell format for all columns to 'General'.
e Manual to choose the cell format of each column as:
o Automatic (based on column contents).
o Boolean (expects true or false, not case-sensitive)
o Date (expects a date format in Preferences).
o General.
o Number (expects a real or integer number, e.g. 123 or 123.456)
o Text.
o Formula (expects starting with =).
o Time (expects hh:mm:ss Of hh:mm, €.g. 13:59:01 Or 13:59).
o Hyperlink (expects a hyperlink, e.g. https://www.easydatatransform.com).

Set Byte Order Mark checked to write a Unicode Byte Order Mark to the file (only available
for UTF encodings and ignored when appending to an existing file).

Set Escape special characters checked to escape HTML special characters (for example <
and >) so they are rendered correctly in the HTML (only available for HTML files). Uncheck it
to write 'raw' HTML. Note that you can also set Change to To escaped HTML to escape
selected columns in the Decode transform.

Check remove empty to recursively remove any nodes that have an empty value and no
children (only available for JSON and XML files). For example:

A AB ABC
1
2 1
3 1

Is output to XML with remove empty checked as:

<root>
<record>
<A>
<B>1</B>
</RA>
</record>
<record>
<A>
<B>
<C>1</C>
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</B>
</A>
</record>
</root>

Is output to XML with remove empty unchecked as:

<root>
<record>
<A>
<B>
<C></C>
</B>
</A>
</record>
<record>
<A>
<B value="1">
<C></C>
</B>
</A>
</record>
<record>
<A>
<B>
<C>1</C>
</B>
</A>
</record>
</root>

Set Root name and Row name depending on the name you want to use for the root and
row XML records (only available for XML files).

Use Write mode to determine how existing files are treated:
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Write mode for File exists with File exists without File does not exist

Excel files named sheet named sheet

Overwrite / File Overwrite named Add named sheet, Create file with only
sheet, delete all delete all other named sheet
other sheets sheets

Overwrite / Sheet  Overwrite named Add named sheet Create file with only
sheet* named sheet

Append Append to named Add named sheet Create file with only
sheet named sheet

New Do nothing Do nothing Create file with only

named sheet

Disabled Do nothing Do nothing Do nothing

*Overwriting a named sheet can cause the file size to increase each time. If this becomes a
problem, you can delete the file and re-output it.

Write mode for non-Excel File exists File does not exist
files

Overwrite Overwrite file Create file
Append Append to file Create file

New Do nothing Create file
Disabled Do nothing Do nothing

Check write header to write the header (only available for Excel, Delimited text, HTML and
Markdown files). If Write mode is Append you can check if empty to only write the header
if the file (sheet for Excel files) is currently empty or does not exist (and not for subsequent
appends).

Use Alias to identify the file for batch processing.

Use Comment to record any notes that might be useful to a colleague or your future self.
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2.5 File formats
2.5.1 File formats

Easy Data Transform supports the following data file formats:

Format Input Output
Delimited text (including Yes Yes
CSV and TSV)

Excel XLSX/XLS Yes Yes
Fixed width Yes No
JSON Yes Yes
HTML No Yes
Markdown No Yes
Plain text Yes Yes
vCard Yes Yes
XML Yes Yes
YAML No Yes

You can manage the default file type for different file extensions in the Input Extensions
and Output Extensions tabs of the Preferences window.

2.5.2 CSV format

Easy Data Transform can input from and output to CSV format files. Default file extension

.CSV'.

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.

CSV is a type of delimited text file format. The column delimiter is usually a comma, but not
always. The row delimiter is line feed, carriage return or carriage return+line feed.

Easy Data Transform supports the following column delimiters:
e Comma (,)

e Semi-colon (;)

e Colon ()
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* Pipe (|)

e Caret ()

e Tab (\t) (used for TSV format)
e Space ()

e Custom (choose your own)

For files padded to fixed column widths with space see Fixed width format. For file with no
column delimiters see Plain text format.

To output to a CSV file you should typically set Delimiter to Comma (,) and Quoting to As
needed in the Right pane.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is output with Delimiter set to Comma (,) and Quoting set to As needed as:

CategoryID, CategoryName, Description,In stock
1,Beverages, "Soft drinks, coffees & teas", true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Note that " quotes have been used to enclose values that contain delimiter characters.
Set Quoting to Always if you want to quote every value. Set Quoting to Never if you don't
want to quote values (delimiters and carriage returns within values will be changed to

spaces).

You will be warned when inputting a CSV format file that has a different number of values
per row. This may be a sign that there are problems with the data (e.g. incorrect quoting).
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Data C 'Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

If you want to input a file with a different delimiter to those listed, then:
1. Input it with a delimiter unlikely to be in the text, e.g. caret (*), to input it as a single

column
2. Use the Split Col transform to transform it into multiple columns using the appropriate
delimiter.

Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

See also TSV format.

2.5.3 Excel format

Easy Data Transform can input from and output to Excel ".xlsx" and "xIs" format files, even if
you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.

You can specify the sheet name when inputting or outputting Excel files using square

brackets, for example:

e MySpreadsheet.xlsx[Sheet1] means the sheet named sheet1 of file
MySpreadsheet.x1lsx (the sheet name is not case sensitive).

e MySpreadsheet.xlsx[1] means sheet named 1 of file MySpreadsheet.x1sx (if it exists)
or else the first sheet.

e MySpreadsheet.xlsx means the first sheet of file MySpreadsheet.x1lsx.

Hyperlinks are read in from Excel in the form anchor |hyperlink.

You can specify how to format columns when outputting to Excel using the Formatting
option.

Please note the following limitations of Excel:
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Excel .xlsx files are limited to 1,048,576 rows and 16,384 columns.

Excel xls files are limited to 65,536 rows and 256 columns.

Date values are input using ISO date format YYYY-MM-DD, regardless of your locale.
Datetime values are input using ISO date format YYYY-MM-DDTHH:MM:SS, regardless of
your locale.

e The following characters are not allowed in sheet names:\ / * [ 1 : 2

2.54 Fixed width format

Easy Data Transform can input from fixed width format files, also known as fixed column
width format. Default file extension ".txt".

Fixed width format is used for exchanging tabular data between programs. It is often
associated with legacy systems, but is also used for large files where performance is an issue
(e.g. bioinformatics).

In fixed width format each column has a fixed width in characters. There is no column
delimiter. Spaces are typically used as padding to make up the column width. The row
delimiter is line feed, carriage return or carriage return+line feed. For example:

ID Name Payment Country Date
8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 US 08/20/2020
7489 Zadie Green 34567.89 DE 08/20/2020
Is input as:

| ID Name Payment Country Date

1 8904 John Black 1234567 GB 08/20/2020

2 3999 Jane Brown 23456.78 US 08/20/2020

'3 7489 Zadie Green 34567.89 DE 08/20/2020

Easy Data Transform will analyze the data and guess the column layout if you set Columns
in the right pane to Automatic. Or you can choose the column widths by setting Columns
to Manual. Click the "..." button to edit the manual column widths.
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fixed-example.txt @ d;’ EC
File: CA\Users\andy\Desktop\fixed-example.txt
L )
(Columns: Manual vl >
e i
€ Fixed Column Widths O X
Width Starts at Ends at
s
Column 2 |5 o7 11
F
Column 3 |8 v 12 19
Y
Column 4 10 - 20 29
Column 5 |9 T 38
FY
Column 6 {10 - |32 48
[
Merge | Split | Insert Left Insert Right Delete Columns: 6
Preview
DUDUDDG[}Dll].'lJ.lll1J.|2222222222333333333344444444-
123456/75901[23456789/0123456789012345678/901234567!
ID Name Payment Country [Date
8904 | John Black 12345.67 GB 0e/20/2021
3998 | Jane Brown 23456.78 [US 08/20/2021
7489 |Fadiel Green [(34567.89 [DE ne/20/20210
| |
OK Cancel = Help

The current column boundaries are shown on the first few rows in the Preview. The
horizontal offset of each character is shown in gray at the top. The currently selected
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columns are highlighted. Click on a column in the Preview to select it in the table, or vice
versa.

You can change the column widths using the Width column of the table.

Select 2 or more adjacent columns and click Merge to merge them into 1 column. Click
then Shift+click in either the table or the preview to select multiple adjacent columns.

Select 1 column with a Width > 1 and click Split to split into 2 columns.

Select 1 or more adjacent columns and click Insert Left or Insert Right to add a new
column with width 1 to the left or right of the selected columns.

Select 1 or more adjacent columns and click Delete delete the selected columns.
Click OK to save your changes and Cancel to discard them.

Unwanted columns and rows in the dataset can be removed after input using the Remove
Cols and Filter transforms.

2.5.5 JSON format
Easy Data Transform can input from and output to JSON format files. Default file extension

"json".

JSON (JavaScript Object Notation) format is commonly used for exchanging data between
programs. JSON data is generally expected to be in UTF8 encoding without a Byte Order

Mark (BOM).
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

[

{
"CategoryID": 1,
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"CategoryName": "Beverages",
"Description": "Soft drinks, coffees & teas",
"In stock": true

"CategoryID": 2,

"CategoryName": "Condiments",
"Description”: "Sweet and savory sauces",
"In stock": false

"CategoryID": 3,

"CategoryName": "Confections",
"Description”: "Candies and sweet breads",
"In stock": true

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

"name": "Avocado Dip",
"carb": 2,
"cholesterol": 5,
"fiber": O,
"minerals": {
"ca": O,
"fe": O
b
"protein": 1,
"sodium": 210,
"vitamins": {
lla": O,
"C": O

Any dots in JSON names are converted to hyphens ('-') on input.

JSON arrays can be input in either long or wide Format. For example:

"name": lllll,

"Values": [ "a", "b" ]
s
{
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"name": "2",
"Values": [ llCll, lldll ]

Input as Long (more rows):

name values
11 a
21 b
32 C
|42 d

Input as Wide (more columns):

name values.0 values.1

11 a b

22 c d

If children of the top level object are named, then they are flattened slightly different to
avoid creating thousands or millions of columns. For example:

{

"record 1":{
"value": 1

b

"record 2":{
"value": 2

b

"record 3":{
"value": 3

}
}

Is flattened into:
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_ObjectName_  value
1 record 1 1
2 record 2 2
3 record 3 3

An input JSON format file is expected to have either:

e asingle top-level array or object; or

¢ asingle JSON object on each line (see jsonlines.org).

e a record separator character followed by a single JSON object on each line (see REC7464).

You can specify the JSON type for each columns when outputting to JSON using the Value
types option. Any values that do not match the type selected are output as a JSON null
value.

2.5.6 HTML format
Easy Data Transform can output to tables in HTML format files. Default file extension

"html".

HTML (HyperText Markup Language) format is commonly used for creating web pages. If
you don't need the data to take up a whole page, you can just copy the <table> to
</table> part of the output.

For example:

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1lpx solid black;text-align:left;vertical-align:top;bord
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</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>

Usually you will want to ‘escape’ special HTML characters in dataset values when output to
HTML format. For example to convert < to s1t;, so it can be correctly displayed in the
HTML. However, if you wish to write 'raw' HTML, then you can uncheck Escape special
characters in the Right pane. Note that you can also set Change to To escaped HTML to
escape selected columns in the Decode transform.

2.5.7 Markdown format

Easy Data Transform can output to tables in Markdown format files. Default file extension
ll.mdll‘

Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.

For example:
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2.5.8

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true

1212 Condiments Sweet and savory sauces false

|

I

| 33 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In stock |
| === [ === [ == e e e | —========= |
|1 | Beverages | Soft drinks, coffees & teas | true
| 2 | Condiments | Sweet and savory sauces | false
| 3 | Confections | Candies and sweet breads | true

You can also use Markdown when you need a plain text version of your data, for example in
a code comment.

Note that not all Markdown implementations support tables. If your implementation does
not support tables, you may need to output to HTML instead.

Plain text format

Easy Data Transform can input from and output to plain text format files. Default file
extension is ".log" for input and ".log" or ".txt" for output.

Plain text format is used for semi-structured data, such as computer generated log files.

When inputting plain text the dataset is read into a single column. The row delimiter is line
feed, carriage return or carriage return+line feed.

For example:

03/22 08:51:01 INFO :..settcpimage: Associate with TCP/IP image name = TCPCS
03/22 08:51:02 INFO :..reg _process: registering process with the system
03/22 08:51:02 INFO :..reg process: attempt 0S/390 registration

03/22 08:51:02 INFO :..reg process: return from registration rc=0

Is input in plain text format as:
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1
1.03/22 08:51:01 INFO ..settcpimage: Associate with TCP/IP image name = TCPCS

2 03/22 08:51:02 INFO :.reg_process: registering process with the system

3 03/22 08:51:02 INFO :.reg_process: attempt OS/390 registration

4 03/22 08:51:02 INFO :..reg_process: return from registration rc=0

When outputting plain text:

e Each row ends with a line feed, carriage return or carriage return+line feed, as selected by
the user.

e Typically plain text datasets only have 1 column. But if there is more than one column, the
column values will be concatenated without a delimiter. If you want a delimiter use Concat
Cols and Remove Cols to create a single column that contains the appropriate delimiters,
or output as delimited text.

¢ Values are not escaped.

2.5.9 TSV format

Easy Data Transform can input from and output to TSV format files. Default file extension
"tsv".

TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format where values are separated by tab characters and
rows by line feed, carriage return or carriage return+line feed. Tabs and carriage return are
not allowed within data values, so there is no need for quoting or escaping delimiters, as
with CSV files. This means that TSV files are generally a bit more compact and faster to read
and write than CSV files.

You will be warned when inputting a TSV format file that has a different number of values
per row. This may be a sign that there are problems with the data.

Data ! 'Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1
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To output to a TSV file you should set Delimiter to Tab (\t) and Quoting to Never in the
Right pane. If you have a tab character or carriage return within a value, then Easy Data
Transform will then convert it to a space on output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is output with Delimiter set to Tab (\t) and Quoting set to Never as:

CategoryID CategoryName Description In stock
1 Beverages Soft drinks, coffees & teas true
2 Condiments Sweet and savory sauces false
3 Confections Candies and sweet breads true

2.5.10 vCard format

Easy Data Transform can input from and output to vCard format files. Default file extension
"vcf",

VCard format is commonly used as way of exchanging contact details between programs.

Note that you need to change the column header names to the values expected by vCard
(using the Rename Cols transform).

For example:

N FN ORG TELTYPE=WORKVOICE ADR;TYPE=WORK,PREF
1 Gump;Forrest;;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest; ;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States of America
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END:VCARD
2.5.11 XML format

Easy Data Transform can input from and output to XML format files. Default file extension

xml'.

XML (Extensible Markup Language) format is commonly used for exchanging data between

programs.
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"7?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>
</record>
<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>
</record>
</root>

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:
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<?xml version="1.0" encoding="UTF-8"7?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Note that the columns may be input in a different order to the nodes in the XML. You can
use Reorder Cols or Stack transforms to change the ordering. But note that during XML
output nodes with no children are always ordered before nodes with children, regardless of
the column order.

Any dots in XML element names are converted to hyphens ('-') on input.

The underscore ('_") character is used at the start of a column header name to identify it as
an XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record carb="2" cholesterol="5" fiber="0" name="Avocado Dip" protein="1" sodium="2
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Repeated XML values can be input in either long or wide Format. For example:
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<?xml version="1.0" encoding="UTF-8"?>
<ITEMS>
<ITEM>
<PARAM name="a" value="1"/>
<PARAM name="b" value="2"/>
</ITEM>
</ITEMS>

Input as Long (more rows):

PARAM. name PARAM. value
1b 2

2a 1

Input as Wide (more columns):

PARAM. value PARAM._name PARAM._value.1 PARAM. name.l
11 a 2 b

You are responsible for ensuring that the names of XML nodes and attributes are valid (e.g.
start with a letter or underscore and do not contain spaces).

2.5.12 YAML format

Easy Data Transform can output to YAML format files. Default file extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data
between programs and for configuration files.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
1212 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:
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CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2

CategoryName: Condiments
Description: Sweet and savory sauces
In stock: false

CategoryID: 3

CategoryName: Confections
Description: Candies and sweet breads
In stock: true

2.6 Comments

You can manage the complexity of large .transform files adding comment text to:

e The Comment field of Note items. These are added to the center pane by right clicking
and selecting Note from the menu. You can also set an Arrow direction and a Color. If
you right click on an existing item, the Note item will be placed pointing to that item, if
there is space. The comment will be shown as a tooltip when you hover over the Note
item.

Deaths by
date

Spread

o

Latest J'-'c"’["n'.',’[',_';'.',',',;ﬁ 2 /Remove Cols , Pwet ,  Sort , Count , Sort | Death
COVID data e . e e AT | frequencies

, Dedupe L . = Join | , Replace b

( Mtl s Filter | ,Num Format | JouLpul.xstJ Deaths by
L] *

p— e — e 2131 e country

ook x 208 s

Scale to per
10k

& ok = 309 rewn
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| output.xlsx
—v O J

! 6 ols % 155 rows

Select items in the center pane
to view

e The Comment tab of Input, Transform or Output items. Check View>Show Comments
to show these comments in the center pane. The comment will be shown as a tooltip
when you hover over the item.

Data  Warnings Info  Comment*

Sum total COVID cases.

Stats

Sum total COVID cases.
11 cols x 14.7k rows

A
Name: Stats
Size: 11 cols x 14.7k s
Transform type: Analysis
Result: Sum row a
Comment: Sum total COVID cases.

[

¢ In the Notes window that is displayed when you select File>Notes... from the main
menu.
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You can also group related items in the center pane to show that they are related.

2.7 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.

vaccination.csv @ Qﬂ Eg
File: ndy\Desktop\vaccination.csv ...
Type: Delimited text v
Delimiter: Automatic .4
Quoting: Automatic v
Encoding: Automatic v

a

Ignore:  First 0 row(s)

v has header

rnm whnitespace

v simplify whitespace

v ignore empty rows

watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Conr < 0

3 cols x 5,780 rows
C E% f © Show first 10 rows ~

Guntry time bcg_vacD

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

You can move 1 or more dataset rows to the header using the Header transform.
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2.8 Connections

When you select an input or transform item and add a transform or output item,
connections are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.

transactions.x... | Filter
—n

35cols x 53.3k rows L} 35 cols x 53.3k rows

To delete a connection

To delete a connection:

e Select the connection.

e Select Edit>Delete (or click the Delete tool bar button).

Note that deleting a connection may unset column related parameters downstream, so

should generally be avoided where possible.

e If you want to change an input file, do it by selecting the input and clicking on "..." in the
Right pane, rather than disconnecting the input and connecting a new one.

e If you want to add a new transform between 2 already connected items, you can do it
without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.
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/" COVID-19-ge..
‘\/[COVID-lQ-ge...

11 cols x 14.7k rows 11 cols x 147k rows

Dedupe

To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.

transactions.x...

35 cols x 53.3k rows lick to connect from this item.

e Hover over the end item
e Click the '+' that appears.

transactions.x...

35 cols x 53.3k rows lick to connect to this item.

Press the 'Esc' key or click away from an item to cancel adding the connection.

Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

e Connect more than once to an output.
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2.9 Text
Whitespace (such as Space and Tab characters) and case are always significant, unless

stated otherwise.

You can remove leading and trailing whitespace by checking trim whitespace in the Input
or using the Whitespace transform.

You can change the case using the Case transform.

You can concatenate and split columns of text using the Concat Cols and Split Col
transforms.

2.10 Dates

Set Supported Date Formats in the Preferences window according to how you want to
interpret values as dates.

Format Meaning

d The day as number without a leading

zero (1to 31)

ele. The day as number with a leading zero
(01 to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun’). Uses the system locale to
localize the name.

drelelel The long localized day name (e.g.
'‘Monday' to 'Sunday'). Uses the system
locale to localize the name.

M The month as number without a leading
zero (1to 12).

L The month as number with a leading zero
(01 to 12)

MM The abbreviated localized month name
(e.g. 'Jan' to 'Dec’). Uses the system locale
to localize the name.

MMMM

The long localized month name (e.g.
‘January' to 'December’). Uses the system
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Format Meaning

locale to localize the name.

Yy The year as two digit number (00 to 99).
yyyy The year as four digit number. If the year
is negative, a minus sign is prepended in
addition.
For example:

e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used first.

Dates with only two year digits, are treated as a date between 1900 and 1999. E.g. "31/1/19"
is interpreted in d-M-yy format as 31st January 1919.

Values that are in a recognized date format will be treated as dates in transforms such as:
Calculate, Compare, Filter, If and Sort. Supporting large numbers of date formats will slow
down these transforms.

You can change the format of dates using the Date Format transform.

You can do date calculations, such as calculating the number of days between 2 dates, using
the Calculate or JavaScript transform.

You can convert an ISO standard datetime (e.g. 2020-10-16T01:51) into separate date and
time columns by using the Split Cols transform on the "T" delimiter.

2.11 Numbers

Set the Locale in the Preferences window according to how you want to interpret values as
numbers. For example, if Locale is set to US or UK then "123.45" is a number and "123,45"
isn't, and vice versa if Locale is Germany or France.

An integer is a whole number. E.g. "1.0" or "1,0" (depending on your Locale), "0", "-1" and
"1e3" are considered integers.

You can change the format of numbers using the Num Format transform.
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You can do numeric calculations, such as multiplying 2 columns, using the Calculate or
JavaScript transform.

2.12 Meta Information

You can add meta information to input data using the Meta info field in the Right pane
when you select an input item. Set it to At start, At end or Every row, depending on where
you want the meta information to appear. Then click on the ... button to edit which
information you wish to show. The following placeholders are substituted by their actual
values at the time of input.

Meta Information Description Example

$ (ComputerName) The name of the MyComputer
computer.

S (CurrentDate) The current date, in 2020-08-18
ISO format.

$ (CurrentDateTime) The current 2020-08-

S (DataColumns)

$ (DataRows)

S (DataValues)

S (FileCreatedDate)

datetime, in ISO
format.

The number of
columns in the
dataset (not
including meta
data).

The number of row
in the dataset (not
including meta
data).

The number of
columns x rows in
the dataset (not
including meta
data).

The date the file
was created, in ISO
format. Only

18T18:00:00

10,000

100,000

2020-08-18
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Meta Information

S (FileCreatedDateTime)

$ (FileName)

S (FilePath)

S (FileSheetName)

S (FileSizeBytes)

$ (FileUpdatedDate)

$ (FileUpdatedDateTime)

Easy Data Transform © 2022 Oryx Digital Ltd

Description

available for file
input.

The datetime the
file was created, in
ISO format. Only
available for file
input.

The name of the
file, including it's
extension. Only
available for file
input.

The full path

(location) of the file.

Only available for
file input.

The name of the
sheet. Only
available for Excel
files.

The size of the file
in bytes. Only
available for file
input.

The date the file
was last updated, in
ISO format. Only
available for file
input.

The datetime the
file was last
updated, in ISO
format. Only
available for file
input.

Example

2020-08-
18T18:00:00

myfile.csv

(CF
\users\andy\Do
cuments\myfile
.Csv

Sheetl

1,234,567

2020-08-18

2020-08-
18T18:00:00
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Meta Information Description Example
$ (UserName) The name of the Andy
user (from the
USER or
USERNAME
environment
variable).
See also:
e Stamp

2.13 Column variables

Some transforms allow you to use the values of columns on the same row using column
variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column; or
e By column index, e.g. s (1) for the first column.

Notes:

e The column name is case sensitive. E.g. column 'A' is referenced by variable s () and
column ‘a' is referenced by variable $ (a).

e Whitespace at the start or end of the column name is ignored. E.g. column ' A" is
referenced by variable $ (»).

e If multiple columns have the same name, the first column from the left with that name will
be used.

e Reference by name takes priority over reference by index. For example, if there is a
column named "1" then s (1) will refer to that rather than the first column.

2.14 Regular expressions

Easy Data Transform allows the use of regular expressions in the Compare, Filter, If, Replace,
Slice and Split Rows transforms. It is also available as part of the JavaScript language in the
JavaScript transform.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match Type Replace With
1/ Regex ¥ O Aw+\s*(\w+) N2\
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Turns:

Full name

1 John Smith
2 Mary Brown

3 Jill Jones

Into:

Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.regular-expressions.info and regexr.com.

2.15 Batch processing

To apply the current . transform file to multiple input files/sheets select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.
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orders.xIsx
@ [orders]
14 cols x 830 rows ‘A\ias: output
‘Alias: orders -
Join output.csv
(/] /9
|Alia5‘ customers 24 cols x 830 rows 24 cols x 830 rows
customers.csv
11 cols x 91 rows

& Batch Process X
Input locations cag¥include wildcards and Excel
E.g. 'C:\Users\and\Documents\*.csv' or 'C:\Users\@ady\Documents\*.xIsx[*]'".
Output locationgitan include variables:
E.g. 'C:\Users\agly\Documents\output\{customers.fndine}.csv
Where

{customers.fflame} is replaced with the file stem of the fgput with alias 'customers'

{customers Skt} is replaced with the file extension of the Wput with alias 'customers'

{orders.fngihe} is replaced with the file stem of the input Wkh alias ‘orders’

{orders.ex¥ is replaced with the file extension of the input alias 'orders’

{orders.sBeet} is replaced with the Excel sheet of the input wily alias "orders’.

{date} e} and {datetime} are replaced by the processing d time and datetime.
Click "Hgip' for more details.

Ad Remove | | Clear

Input alias=customers Input alias=orders Output alias=output (Overwrite)
1/C:\Users\andy\batch\customers.csv ... |C\Users\andy\batch\order* xIsx[*] ... th\out\{orders.fname)}_{orders.sheet}.csv ...
logging Process| Stop v make a sodhd on completion
. orders orders
wildeards file name sheet name
v log results to y\Desktop\batch_log.txt| ... Append ~ Close = Help
Note:

All input and output items must have an alias.

An output item can't have the same alias as another output or input item.
Disconnected input and output items are not shown.

Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.

Click Remove to remove the selected processing row(s).
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Click Clear to remove all processing rows.

Check clear 'Append’ outputs before first append if you want to clear output files you are
appending to before the first append.

Check log results to if you want to log the results to a text file. Set the file location and set
the write mode to Overwrite or Append. You can use {datetime}, {date} and {time} in
the file location.

In the input column(s) you can use * and ? wildcards for file name stems, file extensions and
Excel sheet names. E.g.:

Input Description

C:\Users\andy\Documents\*.csv All files with

extension .csv in the
Documents folder

C:\Users\andy\Documents\d?.csv All the files with
name 'd' plus a single
character in the
Documents folder

C:\Users\andy\Documents\data.xlsx [*] All the sheets in

data.xlsx in the
Documents folder

C:\Users\andy\Documents\*.x1lsx[data*] All the sheets
beginning with 'data’
in all the .xslx files in
the Documents folder

Note:

e If there is more than 1 input column on a row that specifies multiple files or sheets, then
an output will be created for each possible permutation of input files/sheets in the row.
E.g. 3 input files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

e Batch processing will ignore files in sub-folders. Add them as extra rows.

¢ All the files input to an input item or output from an output item should be the same file
type as the original.

In the output column(s) you can use the following variables to create your output file name:
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Output variables

{<input alias>.fname}

{<input alias>.ext}

{<input alias>.sheet}

{<input alias>}

Meaning

The name of the
input file being

processed in the
column with the

corresponding alias.

The extension of
the input file being
processed in the
column with the

corresponding alias.

Does not include
the '.".

The sheet of the
input file being
processed in the
column with the
corresponding alias
(Excel only).

The name of the
input file (plus an
underscore and the
sheet name, if an
Excel file) being
processed in the
column with the

corresponding alias.

Example

If the input with
alias 'orders' is using
file 'C:
\Users\andy\Docum
ents\orders_2020.cs
v' then
{orders.fname}’ is
replaced with value
'orders_2020'".

If the input with
alias 'orders' is using
file 'C:
\Users\andy\Docum
ents\orders_2020.cs
V' then ‘{orders.ext}'
is replaced with
value 'csv'.

If the input with
alias 'orders' is using
file 'C:
\Users\andy\Docum
ents\orders_2020.xls
x' with sheet
‘Sheet1' then
{orders.sheet}' is
replaced with value
‘Sheet1".

If the input with
alias 'orders' is using
file 'C:
\Users\andy\Docum
ents\orders_2020.cs
V' then {orders}' is
replaced with value
‘orders_2020".

If the input with
alias 'orders' is using
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file 'C:
\Users\andy\Docum
ents\orders_2020.xls
x' with sheet
‘Sheet1' then
{orders}' is replaced

with value
‘orders_2020_Sheet
1.
1eRES ) Date processing was 2020_04_18
carried out in
year_month_day
format
{time} Time processing 1521 56_599
was carried out in
hours_minutes_seco
nds_milliseconds
format
letetae] Date/Time 2020_04_18_15_21_
processing was 56_599

carried out in
year_month_day_ho
urs_minutes_second
s_milliseconds
format

Note:

e Whether an output file is created, overwritten or appended to depends on the Write
mode of the output item.

e We recommend you output to a different folder than the one the input files are in.

You can write to multiple sheets of an Excel file, for example:

Input alias=sales Output alias=output (Overwrite)
1/C:\Users\andy\batch\* xIsx[*] ... CA\Users\andy\batch\output\{sales.fname}.xlsx[{sales.sheet}]

But make sure to set the corresponding output Write mode=0Overwrite/Sheet.

Click Process to start processing the rows.
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Click Stop to stop processing the rows.

Check make a sound on completion if you want to play a sound when all processing is
finished.

Click Close to close the window.

See also:
e Batch processing examples
e Command line arguments

2.16 Command line arguments

Easy Data Transform accepts the following command line arguments:

Argument Description

<file name> The .transform file to open at start-up.

@ Close the application once any processing on the opened

file is complete.

~file <alias>=<location> gets the input or output file with the given alias to the

location (path) specified. Input Excel files should include
the sheet name, e.g. file.xlsx[sheet]. Output Excel files
may optionally include a sheet name. The file type should

be the same as the original.
S [RLneeny Don't load the last opened . transform file, even if open
previous file at start-up is checked in Preferences.
-verbose Output additional information to the terminal. Useful for

debugging problems.

This allows you to run Easy Data Transform from the Windows Command Prompt or a .bat
file. For example:

To run C:\Users\andy\Documents\myfile 1.transform with the output with alias output1
output instead to C:\Users\andy\Documents\datal.csv:

"C:\Program Files (x86)\EasyDataTransform v1\EasyDataTransform.exe" "C:\Users\andy\Do

To run C:\Users\andy\Documents\myfile2.transform with the input with alias input1 input
instead from sheet sheet1 of C:\Users\andy\Documents\data 2.xlsx:
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"C:\Program Files (x86)\EasyDataTransform vl\EasyDataTransform.exe" "C:\Users\andy\Do

To use a wildcard to transform multiple files in a folder:

forfiles /p C:\Users\andy\Desktop\cli /m in*.csv /c "cmd /c \"C:\Program Files (x86) \I

Put quotes (") around any arguments with spaces (as shown in the examples above).

To run from the command line on a schedule, call a script file (e.g. .bat or PowerShell) from
a scheduling program, such as Windows Task Scheduler.

Select File>Command Line... to show sample command line text which you can copy and
modify. It will also warn you of potential issues.

See also:
e Batch processing

2.17 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.

The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as 'absolute’ locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it
can't find Input and Output files at the expected location it will look for them in the same
location relative to the old .transform file. This allows you to easily move .transform files to
different locations and computers if you keep the Input and Output files in the same relative
location (e.g. in the same folder as the .transform file). This even works between Windows
and Mac (and vice versa),

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on Windows and uses Input
file MyData.csv in sub-folder Mypata (C:\Users\andy\Documents\Data\MyData.csv).

e mytransform.transformis moved to /Users/Bob/Documents/EDT on a Mac.
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e When mytransform.transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

e If it can't find that it will look for MyData.csv in sub-folder Mypata
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't
recommend you do this for large datasets as XML is not very efficient for storing large
amounts of data.

2.18 Keyboard shortcuts

Using keyboard shortcuts can improve your productivity. If you are using Easy Data
Transform a lot we suggest you find the time to learn at least some of them. The following
keyboard shortcuts are available for the Windows version of Easy Data Transform:

Key Shortcut Action

A Ctrl+a Select all in Center
pane.

B Ctrl+B Show the Batch

Process window.

D Ctrl+D Duplicate the selected
branch in the Center
pane.

B Input From File.
ALL+Shift+l Input From Clipboard.

L Szl Rt Toggle Log pane.

N Ctrl+N New .transform file.

@) Gzl Open .transform file.

Ctrl+Shift+0 Show the Open
Recent window.
RIE0 Output To File.
S Ctrl+s Save .transform file.
T CEwLAT Toggle two screen

mode on/off
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Key

Del

Left arrow

Right arrow

Up arrow

Shortcut

Ctrl+U

Ctrl+Y

Ctrl+z

Del

Ctrl+,

Ctrl+=

Ctrl++

Ctrl+-

Ctrl+lLeft arrow

Alt+Left arrow

Ctrl+Right arrow

Alt+Right arrow

Ctrl+Up arrow

Action

Toggle user interface
between light and
dark themes (if
available).

Redo
Undo

Delete selected
item(s) in Center
pane.

Show Preferences
window.

Zoom Center pane so
all items fit.

Zoom Center pane in.

Zoom Center pane
out.

Move Center pane
selection from item to
highest[1] item that
inputs to it.

Move keyboard focus
to Center pane.

Move Center pane
selection from item to
highest[1] item that it
outputs to.

Move keyboard focus
to Right pane.

Move Center pane
selection from item to
highest[1] sibling[3].
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Key Shortcut Action

Down arrow Ctrl+Down arrow

Move Center pane
selection from item to

lowest[2] sibling[3].

1..9 Ctrl+l...Ctrl+? Select input item 1 to

9 (based on height in
Center pane).

Alt+1...Alt+9 Select output item 1

to 9 (based on height
in Center pane).

F1 Fl Show help.

F11 2L Toggle setting Right
pane item to
fullscreen. Only works
if 1 item in Right
pane.

[1] Highest=nearest the top of the Center pane.

[2] Lowest=nearest the bottom of the Center pane.

[3] Two items are considered siblings if they have inputs from the same item(s) or they both
have no inputs.

You can also use the keyboard to add transforms in the Center pane. Just select the item(s)
you want to add the transform to and start typing the name. Only eligible transform that
contain the typed letters will be displayed (spaces are ignored).

For example, to add the Rename Cols transform an existing Input item:

e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the space key before you start
typing. You can use the Del or Backspace key to undo letters typed.

You can quickly change selection in the Center pane using arrow keys with the ctr1 key.
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Left Arrow Up Arrow

L/ Remove Cols Dedupe

/

4 ols x 14.7k rows 4 ls x 209 rows

Right Arrow

Pivot L/ Sort

2 ols x 210 rows 2 als x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

If you are zoomed in you can scroll the Center pane by pressing the shift key and
dragging the canvas.

2.19 Dark mode

Select View>Toggle Ul Theme (or the corresponding status bar button) to swap between
light and dark user interface themes. You can also change the Center color scheme in the
Colors tab of the Preferences window.
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& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - O X
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3 How do I?

3.1 Add atransform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add or remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

vaccination.csv @ Q{: ES
File: ndy\Desktop\vaccination.csv ... |
Type: Delimited text v
Delimiter: Automatic v
Quoting: Automatic v
Encoding: Automatic v
Ignore:  First O row(s) =
v has header |
nm whitespace
v simplify whitespace i
v ignore empty rows
watch file
Meta info: Not added v
Alias: vaccination

Data = Warnings Info Comr < |}

3 cols x 5,780 rows
C Eg'@ f & Show first 10 rows ~

G:mntf].»r time bcg_vacD
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You can also make the first row of your dataset into a header using the Header transform.
3.3 Change a connection

To change a connection see connections.
3.4 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.

vaccination.csv ® E ;
File: ndy\Desktop\vaccination.csv
Type: Delimited text v
Delimiter: Automatic b4
Quoting: Automatic v
Encodin v
Ignore:  First O row(s) .

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv ® E i
File: \andy\Desktop\output.csv ...
Type: Delimited text v
Delimiter: Comma (,) 5
Quoting: As needed v
Line endings: Automatic v
Encoding: v
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3.5 Convert to percentages

You can convert to percentages using the Scale transform.
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Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale tf’ E i

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item

J Di-s.pgted

1 of 2 columns selected

4)p

Scale to : 100
Using:  Sum v

Of: All values v

v

ltem Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions 20.5633113897

3 Unknown 13.6227590823
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3.6 Duplicate a series of transforms

To duplicate multiple items in the center pane (e.g. a sequence of transforms) right click on
the first item and select Duplicate Branch.

solar.xlsx -
<  [data] L, Javascript » ,Interpolate
6 colks x 2.8k rows ‘ 7 coks x 2.8k rows 8 (U:::p;:::aws
v “’eﬁ'}ﬁg;"“ _I Filter I , Javascript
23 cols x 25.4k rows | 23cols| NP ’
\—J Transform »
Qutput »
Duplicate Branch Ctrl+D
Connect..
Disconnect
Disconnect Upstream
Disconnect Downstream
® Delete Del
solar.xlsx .
s [data] , Javascript » ,Interpolate

i peter Stur &

6 cols x 2.8k rows 8 cols x 2.8k rows

7 cols x 2.8k rows

weather.xlsx
e [data]

23 coks x 25.4k rows

v Filter . v

23 cols x 8.5k rows

script

24 cols x 8.

Interpolate

B petsr atur &
8 cols x 2 8Bk rows

Filter

23 cols x 8.5k rows

Javascript

24 cols x 8.5K rows

3.7 Dedupe a dataset

If you want to remove duplicate entries from a dataset, use the Unique transform. For
example, to remove the 2 rows that have the same email from this dataset:
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i First Last Email

|1J.A. Black jablack@gmail.com

' 2 Paul White p.white@hotmail.com

3 Barry Green bgreeni@aocl.com

4 Jane Brown Jb3423@gmail.com

5J).  Taupe taupe89759@gmail.com

16 John Black jablack@gmail.com

7B.  Green bgreen@acl.com

To get this dataset:

First Last Ermail

1J)A Black jablack@gmail.com

2 Paul White p.white@hotmail.com
3 Barry Green bgreen@aol.com

4 Jane Brown Jb3423@gmail.com

51 Taupe taupe89759@gmail.com

Drag the dataset file onto the Center pane of Easy Data Transform.

mailing.xlsx
[Sheetl]

3 cols x 7 rows

Select the dataset then click the Unique transform in the Left pane.
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mailing.xlsx
o/  [Sheetl]

3 cols x 7 rows

Unique

3 cols x5 rows

Set the Email column to Keep unique in the Right pane. Set the First and Last columns to

Keep first.
Unique @& o3
Column Option
First Keep first v
Last Keep first v
Email Keep unique hs

Keep unique for 1 of 3 columns
Concat delimiter: |,

add count column

Only one row with each email is kept. The first and last names are set to the first occurrence
in the sort order. Use Sort if you want to change the order before removing duplicates.

If you only want to remove rows with the same first name, same last name and same email,
set First, Last and Email columns to Keep unique.

Note that deduplicating columns using Unique takes account of whitespace and case. So
you might need to do Whitespace and Case transforms before the dedupe.

See the Unigue documentation for a more detailed example.
3.8 Find the difference between dates/datetimes

You can calculate the number off days difference between two dates using the Calculate
transform. For example:
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Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

,

Calculate B FE

@ Perform calculations on 1 or 2 columns to create a ne... !

Value 1:  End v

Operation: - Subtract v

Value 2 type: Column v t

Value 2: Start v I
Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

You can convert a datetime into a date using a transform such as Extract.

Alternatively, you can calculate the difference between two dates or datetimes using Date
objects in the JavaScript transform.

There are 4 ways to create a JavaScript Date object:
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Date format Description

new Date(year, month, day, hours, Specified date and time specified as
minutes, seconds, milliseconds) . .
numeric parameters (January is month 0!).

new Date (text date) Date and time specified as text.
new Date(milliseconds) Milliseconds after 1st January 1970.
new Date () Current date and time.

Notes:

e A text date should be in yyyy-mm-dd format.

¢ A Date object always includes a time. If no time is set, then the time is assumed to be
midnight GMT.

¢ One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column and 31st Dec

2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:

return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and 'end' columns in hours:
return ( new Date( $(end) ) - new Date( S$(start) ) ) / ( 60 * 60 * 1000 );
To calculate how many days ago 'date' occurred (rounded down):

return Math.floor( ( new Date() - new Date( $(date) ) ) / ( 24 * 60 * 60 * 1000 ) );:

For more information see the JavaScript documentation.

3.9 Handle column name/order changes in inputs

If you have a .transform file that you want to run multiple input files through (perhaps with
a different input file each month, or as a batch process) you need to be aware of differences
in column name and column order in the input files.
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To change the file being used by an input, select the input item and change the file location
in the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

Same columns in the same order, but with different names

Easy Data Transform references columns by their position (e.g. 3rd column from the left) not
their column name. So differences in column names (e.qg. first column is called "id" in input 1
and "UniquelD" in input 2) are not generally an issue. But you need to be careful if you are
using the Stack transform with Align columns by set to Header name, as this will reorder
columns by name. If you want to always output the same column names, regardless of the
input column names, you should use a Rename Cols transform to set the names.

Same columns with the same names, but in a different order

If columns are in different orders in different input files (e.g. the "id" column in the first
column in input 1 and the second column in input 2) you need to sort the input columns
into a standard order before applying other transforms. You can so this using the Stack
transform with Align columns by set to Header name. Stack your input under a dataset
with columns in the correct order. You can use a Filter to remove any unneeded rows after
the stacking.
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ID title first last

1 dummy

o
F N

. header-order.c...

4 cols x 1 row

.'I . t.
J INpUt.csv

-

4 cols x 2 rows

title first last ID

1Mr  John Smith 001

2 Ms Jane Smith 002

Stack _ @2

Align columns by !

Comment:

Stack rows of all inputs. Orders by the
vertical (Y) position of the input

4 cols x 3 rows i

RB 7
ID title first last
1 dummy
2 001 Mr  John Smith
3 002 Ms  Jane Smith

Stack

4 cols x 3 rows

Filter

v v

4 cols x 2 rows

Ro):

Matching any -

Filter

@ ® keep ~

mn Op Value |
1D Yi|l=v dumnD

4 ¥

Comment:

Filter rows by text, date or numeric
values in selected columns.

4 cols x 2 rows

&<

ID title first last
1001 Mr John Smith
2002 Ms Jane Smith

Same columns with different names, in a different order
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Easy Data Transform can't handle this automatically. But you can create a new .transform
and use Reorder Cols and/or Rename Cols transforms to output to a new file with the
correct column names/ordering. You can then input this to the original .transform.

3.10 Handle datasets with many columns

Easy Data Transform can help you to easily remove or rename columns in datasets with
large numbers of columns.

Remove multiple empty columns
If your dataset has a large number of empty columns you can remove them by checking
ignore empty columns when you input it.

orders.xlsx[orders] Ci: E i
@ Input from file.
File: \EDT northwind data\orders.xlsx[orders] ...
Type: Excel XLSX v
Ignore:  First O row(s) -

v has header

Vv trim whitespace

v simplify whitespace
v ignore empty rows

G ignore empty columns)

watch file

Remove multiple columns

To quickly remove a large number of columns using the Remove Cols transform, you can do

it by filtering column names. For example, to remove the columns with name that contain

"id™:

e Add a Remove Cols transform.

e Type id into the filter field. All the columns whose names contain "id" should now be
visible (not case sensitive).

e Click the Unselect all button.
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e Click the Clear button.
All the columns whose names contain "id" should now be removed by the transform. You
can repeat this process as often as needed.

Remove Cols Qﬂ @ E;'
|
@ Uncheck the column(s) you wish to remove. ]
ol
OrderlD
CustomerlD
EmployeelD

Rename multiple columns

To quickly rename a large number of columns using the Rename Cols transform, you can do

it using Replace text:

¢ Add a Rename Cols transform.

e Click the Replace text button.

e Enter the text you want to Replace and the text you want to replace it With. You can
match as Text, Exact text or Regex, with case sensitive matching optional.

e Click Apply to make the change.

e Click Close.
€ Replace > | Rename Cols & ¥y
- ® Rename column headers.
Match type: |Text \ case sensitive AB
- 5AC
Replace: 1D Old name New name 3
With: Id rderlD Orderld
. A fed Customer|D Customerld
Preview: Changes applie mployeelD Employeel
Close || Apply Or = or e
RequiredDate RequiredDate
See also:

e Handle large datasets
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3.11 Handle large datasets

Large datasets (e.g. a million data points or more) can slow down processing. If slow

processing is a problem you can:

e Add a sample transform straight after the input and set Rows to pass through only the
first 100 or so rows. Once you have completed all your transforms you can then Disable
sampling to pass through all rows.

¢ Set Right pane processing delay in the Preferences window to a longer time (say 5
seconds) to ensure that changes aren't processed until you have finished making the
changes.

¢ Set Maximum memory usage to a higher value in the Preferences window, to ensure
you don't run out of memory.

¢ Set Write mode to Disabled in output files, until you are ready to write them.

See also:
e Handle datasets with many columns

3.12 Input a fixed width format file

To input data from a fixed width file see fixed width format.

3.13 Merge datasets

Easy Data Transform has two main options for merging two datasets. Stack and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:

MName ID DOB

John Black 001 01/07/1966
Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+
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i Name ID DOB

Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name ID DOB
1 Q‘I_I'I Black 001 1966-07-01

2|Paul White 002 1973-03-11

3 @r}f Green 003 19??-12-_5"[}/

4 fane Brown 004 1980-11-02\

Slil\lTaupe 005 1981—(]3-[5}

Drag the two dataset files onto the Center pane of Easy Data Transform.

datasetl.xlsx|...

3 aolsx Irows

dataset2.xIsx]...
v

3 cols x 2 rows

Select the two datasets using ctr1+click then click the Stack transform in the Left pane.
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datasetl.xlsx|...

3 wlsx Irows

Stack

3 olsx Srows

v

dataset2.xlsx[...

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown on the
screen. The top dataset is shown first. You can swap the vertical positions of the datasets to
change the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write
to an output item with Write Mode=Append.

Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:

MName D DO

B ID  Department Level
lﬁn Black 001 1965*3?&

651 Engineering 1—\

=

2 Paul White 002 1973-03-11 2|003 Engineering 2
3 Barry Green @03 1977-12-30 I 3|004 Marketing 1
4 Jane Brown 004 1980-11-03 41002 Sales 2

1]

IS@TEUPE 005 1981{!3—31 QS Sales 3_/
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By common ID value to get this dataset:

Mame ID DOB Department Level

1 dg’h_n Black I(l.'.ll.'.il 1966-07-0 Engineering 1 )
2 |Paul White | 002 [1973-03-11 Sales 2
3|Barry Green| 003 1977-12-3( Engineering 2

4lane Brown| 004 [1980-11-04 Marketing 1

wTaupe @31981—{]3—{};1 Sales 3

Drag the two dataset files onto the Center pane of Easy Data Transform.

(%]

datasetl.xlsx|...

3 alsx Irows

dataset2.xIsx]...
v

3 cols x 2 rows

Select the two datasets using ctr1+click then click the Join transform in the Left pane.
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datasetl.xlsx]...
v

Jcols x5 rows

b/ Join

5 cols x5 rows

dataset2.xlsx|...

3 cols x5 rows

Set both Top key column and Bottom key column to the common (‘key') column.
The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the vertical positions of the datasets to change the order in

which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.

Set include top non-matching rows and include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.

Note that matching columns takes account of whitespace. So you might need to do
Whitespace transform before the join.

If you are merging numerical datasets you can also use an Interpolate transform.

Video: How to join Excel files

3.14 Move a .transform file

To move a .transform file to a different location on the same computer use File>Save As...
or Windows Explorer. You either leave the Input files at the original location or move them
to the same location relative to the .transform file (e.g. if they were in the same folder as the
.transform file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location

relative to the .transform file (e.g. if they were in the same folder as the .transform file
before, move them to the same folder as new .transform file).
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3.15

See also .transform files.

Output nested JSON or XML

You can use the dot ('.") character in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:
[

"name": "Avocado Dip",
"carb": "2",
"cholesterol": "5",
"fiber": "0",
"minerals": {

"Ca": HOH,

"fe": "O"
b
"protein": "1",
"sodium": "210",
"vitamins": {

"a": "O",

e MOV

And to XML as:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

For more details see:

e JSON format
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3.16

e XML format

Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.

& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - O x
Eile Edit View Licensing Help
DEBE v ARG @  rHowDol?

6 afg 1987 27

vaccination2.csv
7 afg 1988 40

Rename Cols (@ Stack (O] 2l
Reorder Cols (2 Align calumns by: Header name v
s R e
Row Num (& datasets
sample (@ Data  Warnings  Info  Comm < *
Slice @ 3 cols x 10,258 raws
Sort @ 3B & @ showfistiOrows ~
Split Col @) ULl e T country time beg_vace
Split Rews (@) 3 eols x 5.8k rows 1 afg 1982 10
spread (@ 2 afg 1983 10
Stack @ Stack 3 alg 1384 11
7
S;::: g JSmllxm-Sch 4 afg 1985 17
5 afg 1986 18
Substitute (&
@
@
@
@
@
@
@

Summa
s b 3 mls x 4.5k rows
Tatal g afg 1389 28
Transpose 9 afg 1990 20
Unigque
qu 10 afg 1991 21
Units
Whitespace Last 10,248 rows not shown
' QOutput

< To File }2),

EEmail us questions/feedback

e Select *.xlsx or *.xls from the file type drop-down list that appears.

File name: | output.csv

Save as type: |CSV file (*.csv)
CSV file (*.csv)

Excel file{*.xls)

~ Falda-e
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Note that Excel .xIsx files are typically limited to 1,048,576 rows and 16,384 columns.

See also:
e Write to multiple sheets of an Excel file

3.17 Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch
processing or command line arguments.

Example 1
To convert a folder full of json files to .csv files:

1. Select File>New to create a new .transform file.

2. Drag one of the .json files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.

test.json output.csv

__p.o.

6 cols x 155 rows 6 cols x 155 rows

V]

4. Select File>Batch Process.
5. In the Batch Process window change the .json file name to *.json, so that all the
.json files in that folder will be processed.
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€ Batch Process* e

Input locations can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\output_*.csv' or 'C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'CA\Users\andy\Documents\output_{test}_{datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias 'test".

And {datetime} is replaced by the processing date and time.

Click "Help' for more details.

Add Remove | | Clear

Input alias=test Output alias=output (Overwrite)
1|C:\Users\andy\Desktop\*’.js-:m ... C\Users\andy\Desktop\output_{test}.csv

Process| Stop

Close Help

6. Press the Process button. A . csv file will now be created for each . json file in the
folder. In the example above {test} will be replaced by the filename of the input file
with alias test (if you just output to output.csv then you would be continually
overwriting the same file).

7. Select File>Save to save your . transform for future use.

If you want to process input files from another folder then click Add to add a new row and
change the input folder.

Example 2
To merge multiple .csv files into a single .csv file:

8. Select File>New to create a new .transforn file.

9. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

10.Click on the To File button at the bottom of the Left pane and set the location of a
merged.csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.
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test.csv merged.csv

9

14 cols x 10k rows

._pg

14 cols x 10k rows

4. In the Right pane set Write Mode to Append and check write header and if empty.

This ensures that only one header will be written, rather than one for every input file.

R A|

5. Select File>Batch Process.

merged.csv 0& e

@ Output to file.

File: C:\Users\andy\Desktop\merged.csv

Type: Delimited text v

Delimiter: Comma (,) v

Quoting: As needed M

Line endings: Automatic v

Encoding:  UTF-8 v
v o

Write modg¢: Append v
v write header v if file empty

Alias: merge

6. In the Batch Process window:

e change the input .csv file name to *.csv, so that all the . csv files in that folder will be
processed.

e Check clear 'Append’ outputs before first append so that any existing data in the
output file is cleared before we start appending to it.
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€ oo

Input locations can include wildcards and Excel sheet names:

E.g. 'C:\Users\andy\Documents\output_*.csv' or 'C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'CA\Users\andy\Documents\output_{test}_{datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias 'test".

And {datetime} is replaced by the processing date and time.

Click "Help' for more details.

Add = Remove | Clear @V clear 'Append' outputs before first append

Input alias=test Output alias=merged (Append)
1/C\Users\andy\Desktop\*.csv ... C\Users\andy\Desktop\merged.csv

Process| Stop

Close Help

7. Press the Process button. A single merged. csv file will now be created that contains a
concatenation of all the other . csv files.
8. Select File>Save to save your . transform for future use.

If the headers are different orders in different .csv files, then you can Stack by header name
in your .transform to get a consistent column order before outputting.
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cols-in-order....

14 cols x 1 row

Stack merged.csv
9 — o9
28 cols x 10k rows 28 cols x 10k rows
test.csv
/]
14 cols x 10k rows
Stack r;f: E C

® Merge input datasets one on top of another. Or...

Align columns by{ Header name v

3.18 Replace empty values

You can replace empty values using the Replace transform.

Easy Data Transform © 2022 Oryx Digital Ltd



How do I?

| nt nZ n3

1 123.8 9876.1

2981234 23.3
3 288
Replace OF Eg

@ Replace multiple text in the selected column(s). Can use powerf...

El Q Filter columns

nt

4

v "

JI"IE

3 of 3 columns selected |
® 1T L ®EE&E X |

Match Type Replace With
1 Empty v 0.0

- I
v case sensitive

y

ni n2 n3

11 123.8 9876.1 0.0

2981234 00 233

3 288 00 00
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3.19 See changes from a transform

The following transforms allow you to highlight changes made by the transform:
e Case

e Chop
Date Format

[ ]
m
x
—+
.y
Q
(@]
—+

e Whitespace

Check the compare changes checkbox below the data table to highlight changes made by
the transform.
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Data = Warnings Info Comment i

3 cols x 4 rows @) 2 changed, 10 unchanged
[ B @Vl &< == T 1L

First Last Gender
1/ Andy M

2 Claire Green F

, detail of
,3 White M selected change

4 Emma Black F

?]compare changes - T ‘john'->'John'

oo U

next/previous change
change color

Click on or hover over a cell to see details of each change.

Click on the up and down arrows to move between changes. Changes hidden by dataset
filtering are skipped.

If you want to see rows that were removed by a transform such as Dedupe, Unique or Filter,
you can do that using Subtract. The dataset needs to have a column of unique key values to
use in the Subtract. If it doesn't have one, then add one first using Row Num.
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orders.csv Row Num » . Subtract
/] — 8 /]
14 cols x 913 rows 15 cols x 913 rows \ 15 cols x B2 rows
Dedupe
© P
15 cols x 830 rows
LJ
Subtract {f B 5:'
@ Remove rows from the top dataset whose key val... |
Top key column: Row Num v
Bottom key column: Row Num v

v case sensitive

3.20 Show whitespace

Click the eye icon in the Right pane to show whitespace in the data.

Data = Warnings @ Info  Comment < »

2 cols x S @) Read
BlE "Y€ 2 AT sk
2 Press to show whitespace in the dataset as symbols:
1 =1 [Space:
Tab: —
2| <2 Carriage return: -
3 ..3. |Line feed: -

Non-breaking space: r
Other whitespace: o
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3.21 Split a dataset into multiple files

Easy Data Transform supports splitting datasets into multiple files in 2 different ways.

Example 1: Simple splitting

To split a dataset according to whether the Gender column contains M or F, use a pair of
Filter transforms.
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Filter d:} E ﬂ
@ Filter rows by text, date or numeric values in sel...

®®E & X Keep ¥ | Matching any

Column Op. Value
1 Gender v¥i= v M
Filter male_employ...
/] — O
19 cols x 10 rows 19 cols x 10 rows
employees.csv
19 cols x 18 rows
Filter female_empl...
V] —» O
19 cols x 8 rows 19 cols x 8 rows

Filter ‘o il === [0
@ Filter rows by text, date or numeric values in sel...

@ ® B &l |X |keep ¥ | Matching any

Column Op. Value
1 Gender Yi|= “YJF

Example 2: Split according to row values

To split a dataset according to Region column values:

e Use transforms (such as Substitute) to create a column with the file location you want to
output to, based on the Region column. The location can be an absolute path (e.g. c:
\users\andy\output.csv) or a path relative to the .transform file location (e.g.
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results\output.csv). Folders output to must already exist. Empty or invalid values are
ignored. This column is not output.

e Create an output with Output to set to Multiple files and the Files column selected.

¢ Set Confirm files checked to be prompted before writing (recommended).
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sales_staff.csv

Easy Data Transform

Name Region

1John Smith  North
2 Jane Green West
3 Brad White  South
4 Faisal Al East

5 Jill Black North

!
1

Substitute
_.o

2 wls x 5 rows 3 cols x 5 rows

v
Type: Delimited text v
N ali S GP PSS

Confirm files:

o Lo

Data =~ Warnings (Dinfo  Comment ¢ »

3 cols x 5 rows @ written
DB/ F VK <> 21T 1YL
Name Region Region file

1John Smith  North  North_staff.csv
2 Jane Green  West West_staff.csv
3 Brad White South  South_staff.csv
4 Faisal Ali East East_staff.csv

5 Jill Black North  North_staff.csv

Multiple files FECZ
@ Output to fi q
Output to: | Multiple files v
Files column: Region file N

l Eﬁ East_staff.csv

© Multiple files > 3 North_staff.csv

3 cols x 5 rows i3 South_staff.csv

E? West_staff.csv

Substitute

New column name: Region file
Substitution script:

$(Region)_staff.csv

Insert variable: <select>

Data = Warnings  Info

3 cols x 5 rows

@ Substitute column values into text.

(6B Z @ F YK <= 21T N WL
Name Region Region file

1John Smith  North  North_staff.csv
2 Jane Green West West_staff.csv
3 Brad White South  South_staff.csv
4 Faisal Ali East East_staff.csv

5 Jill Black North  North_staff.csv

Sl = W3¢

¥ Evaluate

Comment Hile
05 evaluated
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Example 3: Split by size

To split a dataset into files of 1000 rows each:

Multiple files FECS
@ Output to file.
Output to:  Multiple files \
Files column: File name v
L
Row Num
0‘3 — Confirm files: V'
@ Add a new column with the row number. . Type: Excel XLSX -
Start at: 1 - . T
Formatting: Automatic h .
- = .
Increment:| 1 b Write mode: Overwrite ¥ Sheet v E Sp|lt-1 Xlsx
-~ Y .
Every: 1000 = ] write header B split-2.xlsx
1Y .
\ B split-3.xlsx
™ .
O split-4.xlsx
- i Multiple files -
° 10k.csv ° Row Num © Substitute © p | B split-5.xlsx
14 cols x 10k rows 15 cols x 10k rows 16 cols x 10k rows 16 cols x 10k rows E.t Sp|it-5.X|SX
™ .
E split-7.xlsx
™ .
E split-8.xlsx
) X .
Substitute FELe B split-9.xlsx
™ .
(?) substitute column values into text. E split-10.xlsx

New column name: File name
Substitution script:

output\split-$(Row Num).xlsx

3.22 Write to multiple sheets of an Excel file

To write to multiple sheets (tabs) of the same Excel file you need to set the Write mode of
each output item to Overwrite/Sheet (to clear the sheet first) or Append (to add to
existing sheet data).
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RA
customer.xlsx[records] ‘@ d} ¢N

File: »p\customer.xlsx[records] ...

Format as: Number/Bool/Date/Text ~

@e mode: Overwrite ¥ Shee’c) ~

| customers.csv

e

[ customer.xlsx

4*/ [records]

11 cols x 91 rows

N\

11 cols x 91 rows

Sy

customer.xlsx
/ [summary]

Y Summary

12 cols x 9 rows

12 cols x 9 rows

KA
customer.xIsx[summary] l ® YN

File: \customer.xlsx[summary] ...
Format as: Number/Bool/Date/Text ¥
p@e mode: Overwrite ¥ Sheet v

If you set the Write mode to Overwrite/File for an item then the write will remove existing
sheets.
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Expert tips
4.1 Expert tips

Here are some tips to help you be more productive with Easy Data Transform.

1. To add a transform click an existing Center pane item and type the first few letters of the
transform name.

/ COVID-19-geo...
v [COVID-19-ge...

11 cols x :{,\\}.?k rows

2. Check the show advanced checkbox in the Left pane to see all available transforms.

3. Hold down the shift key and drag on the Center pane to scroll left/right/up/down.
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Y Dedupe

{rows 18 cols x 830 rows

Press S

v

\\\
\\\h_

tax-rates.csv

11 cols x 70 rows

4. Use Note items to remind yourself how a complex . transform works.
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! 6 ols % 155 rows

| output.xlsx
—nv Y )

Select items in the center pane
to view

5. Look in the Warnings and Info tabs in the Right pane to troubleshoot potential issues.

Data ! )Warnings @ Info Comment Details

Number of values per row vary:
1 input row has 1 value: E.g. input row 1
43 input rows have 5 values: E.g. input row 27

6. To select multiple items in the Center pane, left click with the mouse and drag a box over
the items you want to select.

7. Try to avoid disconnecting transforms, as this can reset column related options
downstream. Add a transform to an existing connection instead.

8. Add a Sample transform straight after the input of a large dataset and set Rows to pass
through only the first 100 or so rows. Once you have completed all your transforms you can
then Disable sampling to pass through all rows.

9. Click the eye icon in the Right pane to show whitespace in the data.
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Data = Warnings @ Info  Comment < »

2 cols x 3 @) Read
BIlIE Y| | <l= )= N[k
2 Press to show whitespace in the dataset as symbols:
1 =1 [Space:
Tab: -
2 2 . )
Carriage return: -
3 .3. [|Line feed: o

Non-breaking space: r
Other whitespace: o

— —_—

10. Check compare changes in the Right pane to see changes from a transform (selected
transforms only).

Data = Warnings Info Comment L b

3 cols x 4 rows @) 2 changed, 10 unchanged

[ B @Vl &< == T 1L
First Last  Gender

1/ Andy M

2 Claire Green F

, detail of
,3 White M selected change

4 Emma Black F

Ecompare changes - T ‘john'->'John'

next/previous change
change color
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11. Select a column and click the bars icon in the Right pane to show the frequency of

values.
Data Warnings @ Info Corl & Column 'Region’ Value Frequencies X

14 cols x 10,000 rois Value Frequency

) E% &9 Sub-Saharan Africa 2598
Region !

1 Europe Europe 2576 '

2 Middle East and North Afri... Asia 15147-

3 Central America and the C... ARG S el N =t

4 North America Central America and ... 10?0‘

5 |Middle East and North Afri...||\ustrlia and Oceania 788

y North America 219

12. Filter the data in the Right pane.
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Data Warnings Info Comment Details
11 cols x 14,658 rows @) Reac
SHENPZR=IY = &< |22 Tk
dateRep day month year cases dea™

1 2020-05-03 3 5 2020 134

2 2020-05-02 2 E} 5 2020 164

3 2020-05-01 1 5 2020 222

4 2020-04-30 30 4 2020 122

5 2020-04-29 29 4 2020 124

13. If you need several similar branches of transforms you can create one branch and
duplicate it.

14. If you have 2 or more monitors connected to your computer try View>Two Screen
Mode to show the Right pane on your second monitor.

15. Use batch processing with wildcards (e.g. *.csv) to process a folder full of input files in
one operation.

16. Use command line arguments to run . transform files from a batch file.

17. Learn keyboard shortcuts. For example, you can quickly change selection in the Center
pane using arrow keys with the ctr1 key.
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Left Arrow Up Arrow

l\.“,Remr:n.re Cols L/ Dedupe

4 ls x 209 rows

Right Arrow

4 ols x 14.7k rows

Pivot L/ Sort

2 ols x 210 rows 2 als x 210 rows

Spread

v

104 cols x 209 rows

| Down Arrow |

Change focus between the Center and Right panes using Alt+Left and Alt+Right.

18. Change the Center pane color scheme in the Colors tab of the Preferences window.

19. Select View>Toggle Ul Theme to swap between light and dark user interface themes.
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& Easy Data Transform v1,15.0 (licensed to Oryx Digital Ltd)* - O X
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5 Support
5.1 Forum

There is a discussion forum online at forum.easydatatransform.com. You can use this to ask
questions, share what you are doing and keep up to date with news.

5.2 Contact support

If you have any questions or suggestions, please post a question on
forum.easydatatransform.com or email us at support@easydatatransform.com.

5.3 Report a bug

Please report any bugs you find to support@easydatatransform.com Please include:

e your operating system (e.g. Windows 10)

e the version of Easy Data Transform (from Help>About)

e a step-by-step description of how we can reproduce the problem
e your .transform file and input data files (where appropriate)

e a screen capture or video can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.

We treat all data sent to us as confidential, unless you tell us otherwise. If your data is
particularly sensitive, it might be enough to send us just the first few rows with sensitive
values changed. Keep the same column structure though.

5.4 Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please post a feature suggestion on our forum.easydatatransform.com or email
us at support@easydatatransform.com.
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connections 195
copy 219

copycols 46
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cross 49

crosstab 139

CSV format 176
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dark mode 212

date format 50
dates 197
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decode 53

dedupe 55
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duplicate 219

53

207

27

-E-

Excel format 178
expert tips 251
extensions 23
extract 57

-F-
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file splitter 244

fill 59
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Fixed width format 179
forum 260
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group by 64
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header 69, 194
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HTML escape/unescape

if 70
input 24
insert 74

interpolate 76
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Introduction 7

Javascript 80
join 84
JSON format 181
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Left pane 21

Log pane 22
logarithm 27
long pivot 64
lookup 88

-M -

Main window 21
Markdown format 185
meta information 199
month 27

multiply 27
new col 89

newrows 91
ngram 94

num format 96
numbers 198

-0 -

offset 100
output 170
-P-
pad 101
paste 219
percent 217
pivot 103

pivot longer 64

pivot wider 139
Plain text format 186
power 27
preferences 22
Preferences window 22

-Q-

Quick start guide 7

-R -

regular expressions 201
remove cols 106
rename cols 108
reorder cols 109
replace 112

Right pane 22

row num 121

-S-

sample 123

scale 125

scheduling 207
scripting 80

slice 131

sort 133

splitcol 135

split file 244
splitrows 137
spread 139

stack 141

stamp 143

standard deviation 146
stats 146

substitute 148
subtract 27, 150
summary 151
system requirements 7

-T-

text 197
total 155
transpose 158
TSV format 187

-U-

unfill 160

unique 162

units 164

unpivot 64

URL encode/decode 53
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-V -

vCard format 188
vcf format 188

-W -

whitespace 167,243
wide pivot 139

-X -

XML escape/unescape 53
XML format 189

Y-

YAML format 191
year 27
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